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Managing Reports

At scheduled intervals, you can configure the Cisco Mobile Wireless Transport Manager (MWTM) to 
gather critical information from network objects that it detects. The MWTM uses that information to 
calculate statistics (accounting statistics, performance statistics, and so on) and generates reports based 
on those statistics.

You can view reports in several ways:

• From the MWTM web navigation tree, in Reports or File Archive, click the type of report you want 
to view in the web navigation tree; for example, if you want to view current link reports, select 
Reports > Statistics > Link. All link reports appear. See Displaying Status and Summary Reports, 
page 11-12for more information about accessing reports from the web interface.

• For a single object of a specified type do one of the following. From the MWTM:

– Web navigation tree, in DEFAULT View, click a node or drill down to click an object in a node. 
In the content area in the right pane, click the Reports tab. Reports appear for the active object 
only.

– Client, right-click an object and click Latest Reports. The Reports tab in the MWTM web 
interface opens for the active object only.

This section contains:

• Using the Reports Page, page 13-1

• Enabling Automatic Reports Using the CLI, page 13-2

• Viewing Reports, page 13-3

• Locating Stored Reports, page 13-82

• Customizing ITP Reports, page 13-83

• Generating Custom ITP Statistics Reports Using the CLI, page 13-83

Using the Reports Page
To access the main Reports page:

Step 1 Do one of the following:

• In a web browser, launch the MWTM web interface (see Accessing the MWTM Web Interface, 
page 11-2). In the navigation tree, click Reports. 

• From the MWTM client, in the MWTM main window, choose View > Web > Reports.
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The Reports page in the content area shows the Report Type and the status (enabled or disabled). If you 
have generated a report, a green status ball and the word “Enabled” appear in the Status column. If you 
have not generated a report, a red status ball and the word “Disabled” appears.

Note Clicking a Report Type takes you directly to the report data page.

The Status column indicates whether you have enabled or disabled data gathering for the specified report 
type.

Step 2 To enable a report in the MWTM Web interface, click “Disabled” in the Status column. The Status 
changes “Enabled” and a green status ball appears.

Enabling Automatic Reports Using the CLI 
Using CLI commands, there are two types of reports that you can generate: 

• Continuous reports that run at specified intervals. You enable automatic generation of these reports 
with the mwtm statreps commands (see Generating Custom ITP Statistics Reports Using the CLI, 
page 13-83). After you enable generation of a continuous report, it will run at the specified intervals 
until you disable it with the appropriate CLI command. 

• Custom ITP reports that you create one-time on demand. You generate these reports with the mwtm 
abcstats commands where abc is the type of command (see Generating Custom ITP Statistics 
Reports Using the CLI, page 13-83). They run at custom intervals or on demand at the specified 
times. Custom reports are custom because you can specify that they run at custom time intervals. 
The content of custom ITP reports is the same as the regularly scheduled reports. This option is only 
available for ITP reports listed in Table 13-1.

Enabling continuos reports using the CLI is the same as enabling and disabling reports from the Reports 
page.

To enable continuous reports using the CLI:

Step 1 Log in as the root user, as described in Starting the MWTM Client, page 4-2, or as a superuser, as 
described in Specifying a Super User (Server Only), page 2-17.

Step 2 Enter:

cd /opt/CSCOsgm/bin

Step 3 Enter the following CLI command to enable all report types:

./mwtm statreps all

You can enable and disable specific reports using specific CLI commands. For example, to generate 
continuous GTT statistics, enter:

./mwtm statreps gtt

To see a list of all report-related CLI commands, enter the following command:

./mwtm rephelp
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To determine which CLI command generates which report, see Generating Custom ITP Statistics 
Reports Using the CLI, page 13-83.

Step 4 (Optional) View the generated report in the MWTM web interface by clicking Reports in the navigation 
pane as described in Viewing Reports, page 13-3.

Note After you issue the CLI to generate a continuous report, the report is not immediately available for 
viewing. It takes approximately two times the report interval before the report is available.

Viewing Reports
After you generate reports, you can view them using the MWTM web interface. You can view historical 
reports for all objects of a specific type (for example, all link reports for all links) or, you can view 
reports for a specific object (for example, all link reports for a specific link).

You can access reports in the MWTM web interface through these categories:

Category Report Type Related Content

Reports > 
Statistics

AS Application Server Reports, page 13-6

ASP Application Server Process Reports, page 13-8

CPU/Memory CPU/Memory Reports, page 13-13

Events You can find information on event metrics reports in the “Managing Events” chapter 
(see Viewing Event Metrics Report on the Web, page 9-21).

GTT Rates GTT Rates Reports, page 13-19

Link Link Reports, page 13-22

Link Multi-Day Link Multi-Day Report, page 13-28

Linkset Linkset Reports, page 13-29

MLR MLR Reports, page 13-34

MSU Rates MSU Rates Reports, page 13-38

RAN RAN Reports, page 13-40

SCTP SCTP Reports, page 13-47

Reports > 
Accounting

AS/ASP AS/ASP Accounting Reports, page 13-52

GTT GTT Accounting Reports, page 13-53

MTP3 MTP3 Accounting Reports, page 13-54

Reports > 
Subscriber Count

BWG BWG Subscriber Count Reports, page 13-56

CSG2 CSG2 Subscriber Count Reports, page 13-57

GGSN GGSN Subscriber Count Reports, page 13-58

HA HA Subscriber Count Reports, page 13-59

File Archive > 
Events

Events You can find information on archived event reports in the “Managing Events” chapter 
(see Viewing Archived Event Files on the Web, page 9-21).
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To view a Web report:

Step 1 For all objects of a specified type:

• From the MWTM web navigation tree, in Reports or File Archive, click the type of report you want 
to view in the web navigation tree; for example, if you want to view current link reports, select 
Reports > Statistics > Link. All link reports appear.

For a single object of a specified type do one of the following. From the MWTM:

• Web navigation tree, in DEFAULT View, click a node or drill down to click an object in a node. In 
the content area in the right pane, click the Reports tab. Reports appear for the active object only.

• Client, right-click an object and click Latest Reports. The Reports tab in the MWTM web interface 
opens for the active object only.

File Archive > 
Reports

Custom Custom ITP Archived Reports, page 13-61

Daily Daily Archived Reports, page 13-64

Hourly Hourly Archived Reports, page 13-64

15 Minute 15 Minute Archived Reports, page 13-64

Rolling Rolling ITP Archived Reports, page 13-64

APN Access Point Name Archived Reports, page 13-65

AS Application Server Archived Reports, page 13-66

ASP Application Server Process Archived Reports, page 13-67

CSG CSG Archived Reports, page 13-68

CPU CPU Archived Reports, page 13-67

GTT Accounting GTT Accounting Archived Reports, page 13-69

GTT Rates GTT Rates Archived Reports, page 13-69

GGSN GGSN Archived Reports, page 13-70

HA HA Archived Reports, page 13-71

Link Link Archived Reports, page 13-72

Linkset Linkset Archived Reports, page 13-73

Memory Memory Archived Reports, page 13-74

MLR MLR Archived Reports, page 13-74

MSU MSU Archived Reports, page 13-75

MTP3/AS Acct ActivationMTP3/AS Accounting Statistics Archived Reports, page 13-75

MTP3/AS Events MTP3/AS Events Reports, page 13-76

Point Codes Point Code Archived Reports, page 13-77

Q752 Q752 Archived Reports, page 13-78

RAN RAN Archived Reports, page 13-78

SCTP SCTP Archived Reports, page 13-79

Category Report Type Related Content
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Step 2 Choose the Type and Duration from the drop-down lists; for example, if you wanted to view hourly link 
reports for the last 12 hours, choose Link Hourly from the Type list and Last 12 Hours from the 
Duration list. 

Step 3 (Optional) For most Statistics and Accounting reports, to customize the date or time range (or both) click 
the Customize icon.

Step 4 Click the green arrow to run the report. If you change the Type or Duration, an information message 
appears: 

Click the green arrow to show the selected report. 

Step 5 To disable this error message, click Hide Message. To display the message again, click the Information 
icon.

Step 6 (Optional) For Statistics and Accounting reports, to export the report as a .csv file, click the Export 
icon.  

Note For information about all File Archive export reports in csv.zip format, refer to the MWTM 
readme file by clicking Administrative on the navigation pane, then under System Information, 
click Export Reports README. The readme contains documentation on every field in each 
export report, description of the report fields, and in most cases, the SNMP MIB variables used 
to generate the field values.

Note To navigate to the Details tab for an object, click the underlined object in the report; for example, to go 
to the Details tab for a node, click the underlined node in the reports table.

Tip For details on web toolbars and icons, see Using the Toolbar, page 11-5.

Viewing Statistics Reports
You can view any of the following statistics reports:

• Application Server Reports, page 13-6

• Application Server Process Reports, page 13-8

• CPU/Memory Reports, page 13-13

• GTT Rates Reports, page 13-19

• Link Reports, page 13-22

• Link Multi-Day Report, page 13-28

• Linkset Reports, page 13-29

• MLR Reports, page 13-34

• MSU Rates Reports, page 13-38

• RAN Reports, page 13-40

• SCTP Reports, page 13-47
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Application Server Reports

The xUA statistics encompass Message Transfer Part 3 User Adaptation (M3UA) and Signaling 
Connection Control Part User Adaptation (SUA). xUA connects application servers to SS7 networks.

You can view summary reports of hourly and daily application server statistics. You can also export the 
reports.

This section includes:

• Hourly Application Server Reports, page 13-6

• Daily Application Server Reports, page 13-6

• Daily Application Server Peaks Reports, page 13-7

Hourly Application Server Reports

You can view hourly summaries of application server statistics for all application servers that the 
MWTM detects for the specified date and hour range. The AS Hourly Report page shows summary 
reports of hourly application server statistics by date and hour. 

You can view this report by selecting Reports > Statistics > AS, then selecting the specific report from 
the Type pulldown menu.

The AS Report tables are sorted based on the information in the Packets From MTP3 column; however, 
you can sort the table based on the information in one of the other columns (see Navigating Table 
Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Daily Application Server Reports

You can view a daily summary of statistics for all application servers that the MWTM detects for a 
specified date range. The AS Daily Report page shows summary reports of daily application server 
statistics that are archived by date and hour.

You can view this report by selecting Reports > Statistics > AS, then selecting the specific report from 
the Type pulldown menu.

Field or Column Description

Date Date of the report.

Node Name of the node for the application server.

Network Name Name of the network for the application server.

Signaling Point Name of the signaling point for the application server.

AS Name of the application server.

Packets From MTP3 Total number of packets that the application server received, sent from the 
MTP3 layer.

Packets To ASPs Total number of packets that the application server sent to the application 
server processes.
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The AS Daily Report table is sorted based on the information in the Packets From MTP3 column; 
however, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Daily Application Server Peaks Reports

You can view an application server statistics Peaks Report to see peak values for each day and the hour 
in which each peak value occurred. The AS Peaks Daily Report page shows summary reports of daily 
application server peak statistics by date and hour.

You can view this report by selecting Reports > Statistics > AS, then selecting the specific report from 
the Type pulldown menu.

The AS Peaks Daily Report table is sorted based on the information in the Peak From MTP3 column; 
however, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Field or Column Description

Date Date of the report.

Node Name of the node for the application server.

Network Name Name of the network for the application server.

Signaling Point Name of the signaling point for the application server.

AS Name of the application server.

Packets From MTP3 Total number of packets that the application server receives from the MTP3 
layer for the specified date.

Peak From MTP3 Highest hourly Packets From MTP3 for the application server for the specified 
date.

Peak From Hour Hour in which the Peak From MTP3 for the application server occurred for the 
specified date.

Click the hour to see the AS Hourly Report for the chosen application server 
and hour.

Packets To ASPs Total number of packets that the application server sent to the application 
server processes for the specified date.

Peak To ASPs Highest hourly Packets To ASPs for the application server for the specified 
date.

Peak To Hour Hour in which the Peak To ASPs for the application server occurred for the 
specified date.

Click the hour to see the AS Hourly Report for the chosen application server 
and hour.
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Application Server Process Reports

You can view summary reports of hourly and daily xUA statistics. You can also export the reports.

The xUA statistics encompass Message Transfer Part 3 User Adaptation (M3UA) and Signalling 
Connection Control Part User Adaptation (SUA). xUA connects application servers to SS7 networks.

This section covers:

• Hourly Application Server Process Reports, page 13-8

• Daily Application Server Process Reports, page 13-9

• Daily Application Server Process MTP3 Reports, page 13-10

• Daily Application Server Process Peaks Reports, page 13-11

• Daily Application Server Process MTP3 Peaks Reports, page 13-12

Hourly Application Server Process Reports

You can view hourly summaries of statistics for all application server processes that the MWTM detects 
on the specified date and hour. The ASP Hourly Report page shows summary reports of hourly 
application server process statistics by date and hour.

You can view this report by selecting Reports > Statistics > ASP, then selecting the specific report from 
the Type pulldown menu.

The ASP Hourly Report table is sorted based on the information in the Packets From ASP column; 
however, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Field or Column Description

Date Date of the report.

Node Name of the node for the application server.

Network Name Name of the network for the application server.

Signaling Point Name of the signaling point for the application server.

AS Name of the application server that recorded the peak value.

Peak From MTP3 Highest hourly Packets From MTP3 for the application server for the last 30 
days.

Peak From Hour Hour in which the Peak From MTP3 for the application server occurred.

Click the hour to see the AS Hourly Report for the chosen application server and 
hour.

Peak To ASPs Highest hourly Packets To ASPs for the application server for the last 30 days.

Peak To Hour Hour in which the Peak To ASPs for the application server occurred.

Click the hour to see the AS Hourly Report for the chosen application server and 
hour.
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Daily Application Server Process Reports

You can view a daily summary of statistics for all application server processes that the MWTM detects 
on a specified date. The ASP Daily Report page shows summary reports of daily application server 
process statistics, archived by date and hour.

You can view this report by selecting Reports > Statistics > ASP, then selecting the specific report from 
the Type pulldown menu.

The ASP Daily Report table is sorted based on the information in the Packets From ASP column; 
however, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Field or Column Description

Date Date of the report.

Node Name of the node for the application server process.

ASP Name of the application server process.

Packets From ASP Total number of packets that the application server process send for the 
specified date and hour.

Packets To ASP Total number of packets sent to the application server process for the specified 
date and hour.

Packets From MTP3 Total number of packets that the application server process received from the 
MTP3 layer for the specified date and hour.

Packets To MTP3 Total number of packets the application server process sent to the MTP3 layer 
for the specified date and hour.

Send Errors Total number of errors that occurred when sending packets to the application 
server process for the specified date and hour.

Receive Errors Total number of errors that occurred when receiving packets from the 
application server process for the specified date and hour.

Field or Column Description

Date Date of the report.

Node Name of the node for the application server process.

ASP Name of the application server process.

Packets From ASP Total number of packets that the application server process sent for the specified date.

Peak From ASP Highest hourly Packets From ASP for the application server process for the specified date.

Peak From Hour Hour in which the Peak From ASP for the application server process occurred for the specified 
date.

Click the hour to see the ASP Hourly Report for the chosen application server process and hour.
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Daily Application Server Process MTP3 Reports

The ASP MTP3 Daily Report page shows a daily summary of MTP3 statistics for all application server 
processes that the MWTM detects on a specified date. The ASP MTP3 Daily Report page shows a 
summary report of daily application server process MTP3 statistics by date and hour.

You can view this report by selecting Reports > Statistics > ASP, then selecting the specific report from 
the Type pulldown menu.

The ASP MTP3 Daily Report table is sorted based on the information in the Packets From MTP3 
column; however, you can sort the table based on the information in one of the other columns (see 
Navigating Table Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Packets To ASP Total number of packets that the application server sent to the application server processes for 
the specified date.

Peak To ASP Highest hourly Packets To ASP for the application server process for the specified date.

Peak To Hour Hour in which the Peak To ASP for the application server process occurred for the specified date.

Click the hour to see the ASP Hourly Report for the chosen application server process and hour.

Send Errors Total number of errors that occurred when sending packets to the application server processes for 
the specified date.

Peak Send Errors Highest hourly Send Errors for the application server process for the specified date.

Peak Send Hour Hour in which the Peak Send Errors for the application server process occurred for the specified 
date.

Click the hour to see the ASP Hourly Report for the chosen application server process and hour.

Receive Errors Total number of errors that occurred when receiving packets from the application server 
processes for the specified date.

Peak Receive Errors Highest hourly receive errors for the application server process for the specified date.

Peak Receive Hour Hour in which the peak receive errors for the application server process occurred for the specified 
date.

Click the hour to see the ASP Hourly Report for the chosen application server process and hour.

Field or Column Description

Field or Column Description

Date Date of the report.

Node Name of the node for the application server process.

ASP Name of the application server process.

Packets From MTP3 Total number of packets that the application server process receives from the MTP3 layer for the 
specified date.

Peak From MTP3 Highest hourly Packets From MTP3 for the application server process for the specified date.
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Daily Application Server Process Peaks Reports

You can view a report of the statistics peaks for the application server process. The peaks report shows 
peak values for each day of the last 30 days, and the hour in which each peak occurred. The ASP Peaks 
Daily Report page shows a summary report of the daily application server process peak statistics by date 
and hour.

You can view this report by selecting Reports > Statistics > ASP, then selecting the specific report from 
the Type pulldown menu.

The ASP Peaks Daily Report table is sorted based on the information in the Peak From ASP column; 
however, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Peak From Hour Hour in which the Peak From MTP3 for the application server process occurred for the specified 
date.

Click the hour to see the ASP Hourly Report for the chosen application server process and hour.

Packets To MTP3 Total number of packets sent to the MTP3 layer by the application server process for the specified 
date.

Peak To MTP3 Highest hourly Packets To MTP3 for the application server process for the specified date.

Peak To Hour Hour in which the Peak To MTP3 for the application server process occurred for the specified 
date.

Click the hour to see the ASP Hourly Report for the chosen application server process and hour.

Send Errors Total number of errors that occurred when sending packets to the MTP3 layer for the specified 
date.

Peak Send Errors Highest hourly Send Errors for the application server process for the specified date.

Peak Send Hour Hour in which the Peak Send Errors for the application server process occurred for the specified 
date.

Click the hour to see the ASP Hourly Report for the chosen application server process and hour.

Receive Errors Total number of errors that occurred when receiving packets from the MTP3 layer for the 
specified date.

Peak Receive Errors Highest hourly Receive Errors for the application server process for the specified date.

Peak Receive Hour Hour in which the Peak Receive Errors for the application server process occurred for the 
specified date.

Click the hour to see the ASP Hourly Report for the chosen application server process and hour.

Field or Column Description

Field or Column Description

Date Date of the report.

Node Name of the node for the application server process.

ASP Name of the application server process that recorded the peak value.
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Daily Application Server Process MTP3 Peaks Reports

You can view a peaks report of the application server process MTP3 statistics. The peaks report shows 
peak values for each day and the hour in which each peak value occurred. The ASP MTP3 Peaks Daily 
Report page shows summary reports of the daily application server process MTP3 peak statistics by date 
and hour.

You can view this report by selecting Reports > Statistics > ASP, then selecting the specific report from 
the Type pulldown menu.

The ASP MTP3 Peaks Daily Report table is sorted based on the information in the Peak From MTP3 
column; however, you can sort the table based on the information in one of the other columns (see 
Navigating Table Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Peak From ASP Highest hourly Packets From ASP for the application server process for the chosen day.

Peak From Hour Hour in which the Peak From ASP for the application server process occurred for the chosen day.

Click the hour to see the ASP Hourly Report for the chosen application server process and hour.

Peak To ASP Highest hourly Packets To ASP for the application server process for the chosen day.

Peak To Hour Hour in which the Peak To ASP for the application server process occurred for the chosen day.

Click the hour to see the ASP Hourly Report for the chosen application server process and hour.

Peak Send Errors Highest hourly Send Errors for the application server process for the last 30 days.

Peak Send Hour Hour in which the Peak Send Errors for the application server process occurred for the chosen 
day.

Click the hour to see the ASP Hourly Report for the chosen application server process and hour.

Peak Receive Errors Highest hourly Receive Errors for the application server process or the last 30 days.

Peak Receive Hour Hour in which the Peak Receive Errors for the application server process occurred for the chosen 
day.

Click the hour to see the ASP Hourly Report for the chosen application server process and hour.

Field or Column Description

Field or Column Description

Date Date on which the peak values occurred.

Node Name of the node for the application server process.

ASP Name of the application server process that recorded the peak value.

Peak From MTP3 Highest hourly Packets From MTP3 to the application server process for the chosen day.

Peak From Hour Hour in which the Peak From MTP3 to the application server process occurred for the chosen day.

Click the hour to see the ASP Hourly Report for the chosen application server process and hour.

Peak To MTP3 Highest hourly Packets to MTP3 from the application server process for the chosen day.

Peak To Hour Hour in which the Peak to MTP3 from the application server process occurred for the chosen day.

Click the hour to see the ASP Hourly Report for the chosen application server process and hour.
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CPU/Memory Reports

The MWTM web interface provides node-level CPU/memory reports. The information is available in 
graphical, tabular, and CSV formats. There are two types of utilization reports:

• Peak utilization—Displays the maximum (or peak) values obtained during the specified period (for 
example, 15 minutes, hourly, daily).

• Average utilization—Displays the average values obtained during the specified period (for example, 
15 minutes, hourly, daily).

Note The 15-minute and hourly CPU/Memory reports are available from the node level only; they are 
not available from the top level or the network level. 

In addition to generating network-wide CPU/Memory reports as explained in the following steps, you 
can also generate node-level CPU/Memory reports as explained in Generating Node-Level 
CPU/Memory Reports, page 13-51.

To generate a network-wide CPU/Memory reports:

Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > 
CPU/Memory.

A summary table displays the information described in the following table:

Peak Send Errors Highest hourly Send Errors for the application server process for the chosen day.

Peak Send Hour Hour in which the Peak Send Errors for the application server process occurred for the chosen 
day.

Click the hour to see the ASP Hourly Report for the chosen application server process and hour.

Peak Receive Errors Highest hourly Receive Errors for the application server process for the chosen day.

Peak Receive Hour Hour in which the Peak Receive Errors for the application server process occurred for the chosen 
day.

Click the hour to see the ASP Hourly Report for the chosen application server process and hour.

Field or Column Description

Field Description

Node Name of the node for the object

Slot/CPU Slot number (if known) and CPU number

CPU Description Type of CPU

Average Utilization Average utilization across the chosen time range

Maximum Utilization Maximum utilization during the specified time range

Maximum Timestamp 
(timezone)

Timestamp when the maximum utilization occurred

Warning Threshold Threshold setting beyond which a warning is issued

Overload Threshold Threshold setting beyond which is considered overloaded
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Step 2 In the tool bar of the right pane, choose a report type from the Type drop-down menu:

• CPU Peak Utilization Daily Report, page 13-14

• CPU Average Utilization Daily Report, page 13-15

• Memory Peak Utilization Daily Report, page 13-16

• Memory Average Utilization Daily Report, page 13-17

CPU Peak Utilization Daily Report

The CPU Peak Utilization reports displays the CPUs with the highest maximum CPU utilization over the 
specified time period. 

Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > 
CPU/Memory. You can access node-level CPU/Memory reports by clicking on a node name, then 
clicking the Performance tab.

Step 2 From the Type menu, select one of the following CPU utilization reports:

• CPU Peak Utilization Daily

• CPU Average Utilization Daily

Note The 15-minute and hourly CPU/Memory reports are available from the node level only; they are 
not available from the top level or the network level. Click on a node name in the CPU/Memory 
reports to navigate to a specific node to view hourly and 15 minute reports for that node.

A summary table displays the information described in the following table:

Step 3 Select the duration and output (see Using the Toolbar, page 11-5), and the following information is 
displayed:

Field Description

Node Name of the node.

Slot/CPU Slot number (if known) and CPU number.

CPU Description Type of CPU.

Average Utilization Average utilization across the chosen time range.

Maximum Utilization Maximum utilization during the specified time range.

Maximum Timestamp 
(timezone)

Timestamp when the maximum utilization occurred.

Warning Threshold Threshold setting beyond which a warning is issued.

Overload Threshold Threshold setting beyond which is considered overloaded.

GUI Element Description

Graph If you select Graph from the Output menu, the graph displays the 12 CPUs with the highest 
maximum CPU utilization over the specified time period.
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CPU Average Utilization Daily Report

The CPU Average Utilization Daily Reports display the average CPU values gathered during the 
specified period.

Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > 
CPU/Memory. You can access node-level CPU/Memory reports by clicking on a node name, then 
clicking the Performance tab.

Step 2 In the tool bar of the right pane, from the Type menu, select CPU Average Utilization Daily.

A summary table displays the following information:

Step 3 Select the duration and output (see Using the Toolbar, page 11-5), and the following information is 
displayed:

Table If you select Table from the Output menu, the table contains all CPUs monitored by MWTM. By 
default, the CPUs are sorted by maximum CPU utilization. The table includes:

• Node—Name of the node.

• Slot/CPU—Slot number (if known) and CPU number.

• CPU Description—Type of CPU.

• Timestamp (timezone)—Timestamp at which the maximum utilization rate occurred.

• Average Utilization—Average of the data across the chosen time range.

• Maximum Utilization—Maximum utilization during the specified time range.

• Minimum Utilization—Minimum utilization during the specified time range.

• Warning Threshold—Threshold setting beyond which a warning is issued. 

• Overload Threshold—Threshold setting beyond which is considered overloaded.

Expand to Full Screen If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier 
viewing.

Percentage Utilization If Output Type is Graph, the Y-axis label shows percentage of CPU utilization over time.

Time If Output Type is Graph, the X-axis label shows a historical time scale and the server time zone.

Legend If Output Type is Graph, a color-coded legend shows labels for utilization.

Field Description

Node Name of the node.

Slot/CPU Name of the CPU.

CPU Description Description of the CPU.

Average Utilization Average utilization across the chosen time range.

Maximum Utilization Highest utilization of the average values during the specified time range.

Maximum Timestamp 
(timezone)

Timestamp for when the maximum utilization value occurred.

Warning Threshold Threshold setting beyond which a warning is issued. 

Overload Threshold Threshold setting beyond which is considered overloaded.
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Memory Peak Utilization Daily Report

The Memory Peak Daily Utilization reports display the CPUs with the highest memory utilization over 
the specified time period. 

Note The 15-minute and hourly CPU/Memory reports are available from the node level only; they are 
not available from the top level or the network level. Click on a node name in the CPU/Memory 
reports to navigate to a specific node to view hourly and 15 minute reports for that node.

Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > 
CPU/Memory. You can access node-level CPU/Memory reports by clicking on a node name, then 
clicking the Performance tab.

Step 2 From the Type menu, select one of the following Memory utilization reports:

• Memory Peak Utilization 15 minutes

• Memory Peak Utilization Hourly

• Memory Peak Utilization Daily

A summary table displays the following information:

GUI Element Description

Graph If you select Graph from the Output menu, the graph displays the average daily CPU utilization 
over the specified time period.

Table If you select Table from the Output menu, the table contains all CPUs monitored by MWTM. By 
default, the CPUs are sorted by maximum CPU utilization. The table includes:

• Node—Name of the node.

• Slot/CPU—Slot number (if known) and CPU number.

• CPU Description—Type of CPU.

• Timestamp (timezone)—Timestamp at which the maximum utilization rate occurred.

• Average Utilization—Average of the data across the chosen time range.

• Maximum Utilization—Maximum utilization during the specified time range.

• Minimum Utilization—Minimum utilization during the specified time range.

• Warning Threshold—Threshold setting beyond which a warning is issued. 

• Overload Threshold—Threshold setting beyond which is considered overloaded.

Expand to Full Screen If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier 
viewing.

Percentage Utilization If Output Type is Graph, the Y-axis label shows percentage of CPU utilization over time.

Time If Output Type is Graph, the X-axis label shows a historical time scale and the server time zone.

Legend If Output Type is Graph, a color-coded legend shows labels for utilization.
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Step 3 Select the duration and output (see Using the Toolbar, page 11-5), and the following information is 
displayed:

Memory Average Utilization Daily Report

The Memory Average Utilization reports display the average memory values gathered during the 
specified period.

Field Description

Node Name of the node.

Slot/CPU Name of the CPU.

CPU Description Description of the CPU.

Memory Description Type of memory.

Average Utilization Average memory utilization during the specified time range.

Maximum Utilization Maximum memory utilization during the specified time range

Maximum Timestamp 
(timezone)

Timestamp for when the maximum utilization value occurred.

GUI Element Description

Graph If you select Graph from the Output menu, the graph displays the CPUs with the highest memory 
utilization over the specified time period.

Table If you select Table from the Output menu, the table contains all CPUs monitored by MWTM. By 
default, the CPUs are sorted by maximum CPU utilization. The table includes:

• Node—Name of the node.

• Slot/CPU—Slot number (if known) and CPU number.

• CPU Description—Type of CPU.

• Timestamp (timezone)—Timestamp at which the maximum utilization rate occurred.

• Memory Type—Type of memory, which can be processor, I/O, Fast, etc.

• Average Utilization—Average of the data across the chosen time range.

• Maximum Utilization—Maximum utilization during the specified time range.

• Minimum Utilization—Minimum utilization during the specified time range.

• Total—Average Used plus Average Free memory during the specified time frame.

• Average Used—Average memory used during the specified time range.

• Average Free—Average memory available during the specified time range.

Expand to Full Screen If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier 
viewing.

Percentage Utilization If Output Type is Graph, the Y-axis label shows percentage of memory utilization over time.

Time If Output Type is Graph, the X-axis label shows a historical time scale and the server time zone.

Legend If Output Type is Graph, a color-coded legend shows labels for utilization.
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Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > 
CPU/Memory. You can access node-level CPU/Memory reports by clicking on a node name, then 
clicking the Performance tab.

Step 2 From the Type menu, select one of the following Memory utilization reports:

• Memory Average Utilization 15 minutes

• Memory Average Utilization Hourly

• Memory Average Utilization Daily

Note The 15-minute and hourly CPU/Memory reports are available from the node level only; they are 
not available from the top level or the network level. Click on a node name in the CPU/Memory 
reports to navigate to a specific node to view hourly and 15 minute reports for that node.

A summary table displays the following information:

Step 3 Select the duration and output (see Using the Toolbar, page 11-5), and the following information is 
displayed:

Field Description

Node Name of the node.

Slot/CPU Name of the CPU.

CPU Description Description of the CPU.

Memory Description Type of memory.

Average Utilization Average memory utilization during the specified time range.

Maximum Utilization Highest memory utilization of the average values during the specified time 
range.

Maximum Timestamp 
(timezone)

Timestamp for when the maximum utilization value occurred.

GUI Element Description

Graph If you select Graph from the Output menu, the graph displays the average memory utilization over 
the specified time period.
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GTT Rates Reports

You can view peak GTT rates or average GTT rates. The information is available in graphical, tabular, 
and CSV formats. There are two types of GTT rates reports:

• Peak utilization—Displays the maximum (or peak) GTT rates obtained during the specified period 
(for example, 15 minutes, hourly, daily).

• Average utilization—Displays the average values obtained during the specified period (for example, 
15 minutes, hourly, daily). 

Note The 15-minute and hourly reports for GTT Rates are available from the node level only; they are 
not available from the top level or the network level.

This section covers:

• GTT Rate Peak Reports, page 13-19

• GTT Rate Average Reports, page 13-21

GTT Rate Peak Reports

MWTM displays the maximum (or peak) GTT rates obtained during the specified period (for example, 
15 minutes, hourly, or daily).

Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > GTT 
Rates.

Table If you select Table from the Output menu, the table contains all CPUs monitored by MWTM. By 
default, the CPUs are sorted by maximum CPU utilization. The table includes:

• Node—Name of the node.

• Slot/CPU—Slot number (if known) and CPU number.

• CPU Description—Type of CPU.

• Timestamp (timezone)—Timestamp at which the maximum utilization rate occurred.

• Memory Type—Type of memory, which can be processor, I/O, Fast, etc.

• Average Utilization—Average of the data across the chosen time range.

• Maximum Utilization—Maximum utilization during the specified time range.

• Minimum Utilization—Minimum utilization during the specified time range.

• Total—Average Used plus Average Free memory during the specified time frame.

• Average Used—Average memory used during the specified time range.

• Average Free—Average memory available during the specified time range.

Expand to Full Screen If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier 
viewing.

Percentage Utilization If Output Type is Graph, the Y-axis label shows percentage of memory utilization over time.

Time If Output Type is Graph, the X-axis label shows a historical time scale and the server time zone.

Legend If Output Type is Graph, a color-coded legend shows labels for utilization.
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Step 2 From the Type pulldown menu, select a GTT Rate Peak report, which can be 15-minute, hourly, or daily).

Note The 15-minute and hourly reports for GTT Rates are available from the node level only; they are 
not available from the top level or the network level. Click on a node name in the GTT Daily 
reports to navigate to a specific node to view hourly and 15 minute reports for that node.

Step 3 Select a duration, and output type. See Using the Toolbar, page 11-5.

A summary table contains the information described in the following table:

The GTT Rate Daily reports contain the following information:

Field Description

Node Name of the node for the object. You can click on a node name to see 
node-specific reports.

Slot/CPU Slot number (if known) and CPU number.

CPU Description Type of CPU.

Average GTT Rate Average GTT rate for the specified duration.

Maximum GTT Rate Maximum GTT rate during the specified duration.

Maximum Timestamp 
(timezone)

Timestamp when the maximum GTT rate occurred.
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GTT Rate Average Reports

MWTM displays the average GTT rates obtained during the specified period (for example, 15 minutes, 
hourly, daily).

Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > GTT 
Rates.

Step 2 From the Type pulldown menu, select a GTT Rate Average report, which can be 15-minute, hourly, or 
daily). 

Note The 15-minute and hourly reports for GTT Rates are available from the node level only; they are 
not available from the top level or the network level. Click on a node name in the GTT Daily 
reports to navigate to a specific node to view hourly and 15 minute reports for that node.

Step 3 Select a duration, and output type. See Using the Toolbar, page 11-5.

A summary table contains the information described in the following table:

GUI Element Description 

Table If you select the Output Type Table, the table contains:

• Node

• Slot/CPU

• CPU Description

• Timestamp (timezone)

• Average GTT Rate

• Maximum GTT Rate

• Minimum GTT Rate

Note If the Output Type is Table or CSV, the same data is presented but the column headings are 
labeled by data type.

The GTT Rate Peak Report table is sorted based on the value in the Maximum GTT Rate column. 
However, you can sort the tables based on the information in one of the columns (see Navigating 
Table Columns, page 5-22).

Expand to Full Screen If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier 
viewing.

GTT (Secs) If Output Type is Graph, Y-axis label that shows the Global Title Translations per second. 

Note If no data exists between any two data points, the graph displays a color-coded vertical bar 
to show the period for which no data is available.

Time If Output Type is Graph, X-axis label that shows a historical time scale and the server time zone.

Legend If Output Type is Graph, color-coded legend that shows labels for output.
13-21
User Guide for the Cisco Mobile Wireless Transport Manager 6.1.1

OL-13314-01



 

Chapter 13      Managing Reports
  Viewing Reports
The GTT Rate Average reports display the following information:

Link Reports

You can view summary reports of hourly and daily statistics for links, and export the reports.

This section covers:

• Hourly Link Reports, page 13-23

• Daily Link Reports, page 13-24

Field Description

Node Name of the node for the object. You can click on a node name to see 
node-specific reports.

Slot/CPU Slot number (if known) and CPU number.

CPU Description Type of CPU.

Average GTT Rate Average GTT rate for the specified duration.

Maximum GTT Rate Maximum GTT rate during the specified duration.

Maximum Timestamp 
(timezone)

Timestamp when the maximum GTT rate occurred.

Field or Column Description

Table If you select the Output Type Table, the table contains:

• Node

• Slot/CPU

• CPU Description

• Timestamp (timezone)

• Average GTT Rate

• Maximum GTT Rate

• Minimum GTT Rate

Note If the Output Type is Table or CSV, the same data is presented but the column headings 
are labeled by data type.

The GTT Rate Average Report table is sorted based on the information in the Average GTT Rate 
column. However, you can sort the tables based on the information in one of the columns (see 
Navigating Table Columns, page 5-22).

Expand to Full Screen If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier 
viewing.

GTT (Secs) If Output Type is Graph, Y-axis label that shows the Global Title Translations per second. 

Note If no data exists between any two data points, the graph displays a color-coded vertical 
bar to show the period for which no data is available.

Time If Output Type is Graph, X-axis label that shows a historical time scale and the server time zone.

Legend If Output Type is Graph, color-coded legend that shows labels for output.
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• Daily Link Peaks Reports, page 13-26

• Link Multi-Day Report, page 13-28

Hourly Link Reports

You can view hourly summaries of statistics for all links or a specific link that the MWTM detected on 
the specified date and hour. The Link Hourly Report page shows summary reports of hourly link 
statistics by date and hour. You can also graph the results.

The Link Hourly Report table is sorted based on the information in the Send Average Utilization column; 
however, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > Link.

Step 2 In the tool bar of the right pane, from the Type drop-down menu, select Link Hourly Statistics. (See 
Table 13-1 for a list of report types and their contents).

Step 3 Choose a time range from the Duration drop-down menu or customize your own time range by clicking 
the Customize icon .

Step 4 Choose an output format (Graph, Table, or CSV) from the Output drop-down menu (see Table 13-1 for 
contents of each output type).

The Send Utilization and Receive Utilization tables contain summary information as described below:

Depending on what you select from the Output pulldown menu, the following information is displayed:

Field or Column Description

Node Name of the node for the link.

Signaling Point Name of the signaling point for the link.

Linkset Linkset for the object.

SLC ID of the link.

Average Average Send or Receive for the link for the specified time.

Minimum Minimum Send or Receive for the specified time.

Minimum Timestamp (timezone) Timestamp when the minimum value occurred.

Maximum Maximum Send or Receive for the specified time.

Maximum Timestamp (timezone) Timestamp when the maximum value occurred.

Field or Column Description

Graph

Expand to Full Screen If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier 
viewing.

Utilization Percentage If Output Type is Graph, the Y-axis label shows hourly statistics over time.
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Daily Link Reports

You can view daily summaries of statistics for all links or for a specific link that the MWTM detected 
on the specified date and hour. The Link Daily Report page shows summary reports of daily link 
statistics by date and hour.

The Link Daily Report table is sorted based on the information in the Avg Send  or Avg Send Erlangs 
column. However, you can sort the table based on the information in one of the other columns (see 
Navigating Table Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Time If Output Type is Graph, the X-axis label shows a historical time scale and the server time zone.

Legend If Output Type is Graph, a color-coded legend shows labels for utilization.

Table, CSV

Date Date of the report.

Node Name of the node for the link.

SP Name Name of the signaling point for the link.

Linkset Name Linkset for the object.

SLC ID of the link.

Timestamp (timezone) Timestamp of the report

Type Type of link. Possible link types are:

• HSL—Uses the SS7-over-ATM (Asynchronous Transfer Mode) high-speed protocol.

• SCTP—Uses the Stream Control Transmission Protocol (SCTP) IP transport protocol.

• Serial—Uses the serial SS7 signaling protocol.

• Virtual—A virtual link that connects signaling point instances that run on the same node. The 
MWTM does not poll virtual links; nor does it display real-time data or accounting statistics 
for virtual links.

Hourly In-Service Percentage of time the link was in service on the specified date and hour.

Long Term In-Service Average percentage of time the link was in service since MWTM polling began for the link, or since 
the MWTM last reset the averages as a result of bad data.

Congestion % Percentage of time the link was congested on the specified date and hour.

Average Utilization Average Send or Receive for the link, expressed as a percentage or number of Erlangs (E) (as set 
with the mwtm webutil command) for the specified date and hour.

If you do not set the planned send capacity for the SCTP link, then NoCap appears in the field.

Long Term Average 
Utilization

Long-term average Send or Receive for the link, expressed as a percentage or number of Erlangs 
(E) (as set with the mwtm webutil command), since MWTM polling began for the link, or since the 
MWTM last reset the averages as a result of bad data.

If you do not set the planned send capacity for the SCTP link, then NoCap appears in the field.

MSUs Total number of MTP3 message signal units (MSUs) sent and received on the specified date and 
hour.

Field or Column Description
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Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > Link.

Step 2 In the tool bar of the right pane, from the Type drop-down menu, select Link Daily Statistics. (See 
Table 13-1 for a list of report types and their contents).

Step 3 Choose a time range from the Duration drop-down menu or customize your own time range by clicking 
the Customize icon .

Step 4 Choose an output format (Graph, Table, or CSV) from the Output drop-down menu (see Table 13-1 for 
contents of each output type).

The Send Utilization and Receive Utilization tables contain summary information as described below:

Depending on what you select from the Output pulldown menu, the following information is displayed:

Field or Column Description

Node Name of the node for the link.

Signaling Point Name of the signaling point for the link.

Linkset Linkset for the object.

SLC ID of the link.

Average Average Send or Receive for the link for the specified time.

Minimum Minimum Send or Receive for the specified time.

Minimum Timestamp (timezone) Timestamp when the minimum value occurred.

Maximum Maximum Send or Receive for the specified time.

Maximum Timestamp (timezone) Timestamp when the maximum value occurred.

Field or Column Description

Graph

Expand to Full Screen If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier 
viewing.

Utilization Percentage If Output Type is Graph, the Y-axis label shows daily link statistics over time.

Time If Output Type is Graph, the X-axis label shows a historical time scale and the server time zone.

Legend If Output Type is Graph, a color-coded legend shows labels for utilization.

Table, CSV

Date Date of the report.

Node Name of the node for the link.

SP Name Name of the signaling point for the link.

Linkset Name Linkset for the object.

SLC ID of the link.

Timestamp (timezone) Timestamp of the report
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Daily Link Peaks Reports

You can view a daily link statistics peaks report using the Link Peaks Daily Report page. The peaks 
report shows peak values for each day and the hour in which each peak value occurred. 

The Link Peaks Daily table is sorted based on the information in the Peak Send  or Peak Send Erlangs 
column. However, you can sort the table based on the information in one of the other columns (see 
Navigating Table Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > Link.

Type Type of link. Possible link types are:

• HSL—Uses the SS7-over-ATM (Asynchronous Transfer Mode) high-speed protocol.

• SCTP—Uses the Stream Control Transmission Protocol (SCTP) IP transport protocol.

• Serial—Uses the serial SS7 signaling protocol.

• Virtual—A virtual link that connects signaling point instances that run on the same node. 
The MWTM does not poll virtual links; nor does it display real-time data or accounting 
statistics for virtual links.

Daily In-Service Percentage of time the link was in service on the specified date.

Long Term In-Service Average percentage of time the link was in service since MWTM polling began for the link, or 
since the MWTM last reset the averages as a result of bad data.

Daily Low In-Service Lowest hourly in-service percentage for the link for the specified date.

Low Service Hour Hour in which the lowest in-service percentage occurred for the specified date.

Avg Congestion % Average percentage of time the link was congested on the specified date.

Average Utilization Average Send or Receive for the link, expressed as a percentage or number of Erlangs (E) (as set 
with the mwtm webutil command) for the specified date and hour.

If you do not set the planned send capacity for the SCTP link, then NoCap appears in the field.

Peak Utilization Highest Send or Receive for the link, expressed as a percentage or number of Erlangs (E) (as set 
with the mwtm webutil command) for the specified date and hour.

If you do not set the planned send capacity for the SCTP link, then NoCap appears in the field.

Peak Hour Hour in which the Peak Send or Peak Receive for the link occurred for the specified date. 

Click the hour to see the Link Hourly Report for the chosen link and hour.

Long Term Average 
Utilization

Long-term average Send or Receive for the link, expressed as a percentage or number of Erlangs 
(E) (as set with the mwtm webutil command), since MWTM polling began for the link, or since 
the MWTM last reset the averages as a result of bad data.

If you do not set the planned send capacity for the SCTP link, then NoCap appears in the field.

MSUs Total number of MTP3 message signal units (MSUs) sent and received on the specified date and 
hour.

Field or Column Description
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Step 2 In the tool bar of the right pane, from the Type drop-down menu, select Link Peaks Daily Statistics. (See 
Table 13-1 for a list of report types and their contents).

Step 3 Choose a time range from the Duration drop-down menu or customize your own time range by clicking 
the Customize icon .

Step 4 Choose an output format (Graph, Table, or CSV) from the Output drop-down menu (see Table 13-1 for 
contents of each output type).

The Send Utilization and Receive Utilization tables contain summary information as described below:

Depending on what you select from the Output pulldown menu, the following information is displayed:

Field or Column Description

Node Name of the node for the link.

Signaling Point Name of the signaling point for the link.

Linkset Linkset for the object.

SLC ID of the link.

Average Average Send or Receive for the link for the specified time.

Minimum Minimum Send or Receive for the specified time.

Minimum Timestamp (timezone) Timestamp when the minimum value occurred.

Maximum Maximum Send or Receive for the specified time.

Maximum Timestamp (timezone) Timestamp when the maximum value occurred.

Field or Column Description

Graph

Expand to Full Screen If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier 
viewing.

Utilization Percentage If Output Type is Graph, the Y-axis label shows daily link statistics over time.

Time If Output Type is Graph, the X-axis label shows a historical time scale and the server time zone.

Legend If Output Type is Graph, a color-coded legend shows labels for utilization.

Table, CSV

Date Date of the report.

Node Name of the node for the link.

SP Name Name of the signaling point for the link.

Linkset Name Linkset for the object.

SLC ID of the link.

Timestamp (timezone) Timestamp of the report
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Link Multi-Day Report

The Link Multi-Day Report page shows send and receive percentages for all links for the last three or 
five days. 

The Link Multi-Day table is sorted based on the information in the Avg Send  column. However, you can 
sort the table based on the information in one of the other columns (see Navigating Table Columns, 
page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > Link 
Multi-Day.

Step 2 In the tool bar of the right pane, from the Type pulldown menu, select Link Multi-Day. (See Table 13-1 
for a list of report types and their contents).

Step 3 Choose a time range from the Duration drop-down menu or customize your own time range by clicking 
the Customize icon .

Step 4 Choose an output format (Graph, Table, or CSV) from the Output drop-down menu (see Table 13-1 for 
contents of each output type).

The information described in the following table is displayed for the duration you selected.

Type Type of link. Possible link types are:

• HSL—Uses the SS7-over-ATM (Asynchronous Transfer Mode) high-speed protocol.

• SCTP—Uses the Stream Control Transmission Protocol (SCTP) IP transport protocol.

• Serial—Uses the serial SS7 signaling protocol.

• Virtual—A virtual link that connects signaling point instances that run on the same node. 
The MWTM does not poll virtual links; nor does it display real-time data or accounting 
statistics for virtual links.

Peak Utilization Highest Send or Receive for the link, expressed as a percentage or number of Erlangs (E) (as set 
with the mwtm webutil command) for the specified date and hour.

If you do not set the planned send capacity for the SCTP link, then NoCap appears in the field.

Peak Hour Hour in which the Peak Send or Peak Receive for the link occurred for the specified date. 

Click the hour to see the Link Hourly Report for the chosen link and hour.

Long Term Average 
Utilization

Long-term average Send or Receive for the link, expressed as a percentage or number of Erlangs 
(E) (as set with the mwtm webutil command), since MWTM polling began for the link, or since 
the MWTM last reset the averages as a result of bad data.

If you do not set the planned send capacity for the SCTP link, then NoCap appears in the field.

MSUs Total number of MTP3 message signal units (MSUs) sent and received on the specified date and 
hour.

Field or Column Description
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Note If there are less than five days of data available, the Link Multi-Day Report displays N/A for the days 
for which there is no data.

Linkset Reports

You can view summary reports of hourly and daily statistics for linksets, and export the reports.

This section covers:

• Hourly Linkset Reports, page 13-29

• Daily Linkset Reports, page 13-31

• Daily Linkset Peaks Reports, page 13-32

Hourly Linkset Reports

You can view hourly summaries of statistics for all linksets or for a specific linkset that the MWTM 
detected on the specified date and hour. The Linkset Hourly Report page shows summary reports for all 
archived MWTM hourly linkset statistics by date and hour.

The Linkset Hourly Report table is sorted based on the information in the Send Utilization column. 
However, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > Linkset.

Step 2 In the tool bar of the right pane, from the Type drop-down menu, select Linkset Hourly Statistics. (See 
Table 13-1 for a list of report types and their contents).

Step 3 Choose a time range from the Duration drop-down menu or customize your own time range by clicking 
the Customize icon .

Field or Column Description

Node Name of the node for the link.

Network Name Name of the network for the link.

Signaling Point Name of the signaling point for the link.

Link Name of the link.

Avg. Send Utilization Send for the link, expressed as a percentage or number of Erlangs (E) (as set with the 
mwtm webutil command) for each of the last five days.

If you do not set the planned send capacity for the SCTP link, then NoCap appears in the field.

Avg. Receive Utilization Receive for the link, expressed as a percentage or number of Erlangs (E) (as set with the 
mwtm webutil command) for each of the last five days.

If you do not set the planned receive capacity for the SCTP link, then NoCap appears in the field.
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Step 4 Choose an output format (Graph, Table, or CSV) from the Output drop-down menu (see Table 13-1 for 
contents of each output type).

The Send Utilization and Receive Utilization tables contain summary information as described below:

Depending on what you select from the Output pulldown menu, the following information is displayed:

Field or Column Description

Node Name of the node for the linkset.

Signaling Point Name of the signaling point for the linkset.

Linkset Linkset for the object.

Average Average Send or Receive for the linkset for the specified time.

Minimum Minimum Send or Receive for the specified time.

Minimum Timestamp (timezone) Timestamp when the minimum value occurred.

Maximum Maximum Send or Receive for the specified time.

Maximum Timestamp (timezone) Timestamp when the maximum value occurred.

Field or Column Description

Graph

Expand to Full Screen If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier 
viewing.

Utilization Percentage If Output Type is Graph, the Y-axis label shows hourly linkset utilization over time.

Time If Output Type is Graph, the X-axis label shows a historical time scale and the server time zone.

Legend If Output Type is Graph, a color-coded legend shows labels for utilization.

Table, CSV

Date Date of the report.

Node Name of the node for the linkset.

SP Name Name of the signaling point for the linkset.

Linkset Name Linkset for the object.

Hourly In-Service Percentage of time the linkset was in service on the specified date.

Long Term In-Service Average percentage of time the linkset was in service since MWTM polling began for the link, 
or since the MWTM last reset the averages as a result of bad data.

Send Utilization Average Send for the linkset, expressed as a percentage or number of Erlangs (E) (as set with the 
mwtm webutil command) for the specified date and hour.

If you do not set the planned send capacity for one or more of the SCTP links associated with the 
linkset, then NoCap appears in the field.

Long Term Send 
Utilization

Long-term average Send for the linkset, expressed as a percentage or number of Erlangs (E) (as 
set with the mwtm webutil command), since MWTM polling began for the linkset, or since the 
MWTM last reset the averages as a result of bad data.

If you do not set the planned send capacity for one or more of the SCTP links associated with the 
linkset, then NoCap appears in the field.
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Daily Linkset Reports

You can view daily summaries of statistics for all linksets or for a specific linkset that the MWTM 
detected on the specified date and hour. The Linkset Daily Report page shows summary reports of all 
archived MWTM daily linkset statistics by date and hour.

The Linkset Daily Report table is sorted based on the information in the Send Average column. You can 
sort the table based on the information in one of the other columns (see Navigating Table Columns, 
page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > Linkset.

Step 2 In the tool bar of the right pane, from the Type drop-down menu, select Linkset Daily Statistics. (See 
Table 13-1 for a list of report types and their contents).

Step 3 Choose a time range from the Duration drop-down menu or customize your own time range by clicking 
the Customize icon .

Step 4 Choose an output format (Graph, Table, or CSV) from the Output drop-down menu (see Table 13-1 for 
contents of each output type).

The Send Utilization and Receive Utilization tables contain summary information as described below:

Depending on what you select from the Output pulldown menu, the following information is displayed:

Receive Utilization
or
Receive Erlangs

Average Receive for the linkset, expressed as a percentage or number of Erlangs (E) (as set with 
the mwtm webutil command) for the specified date and hour.

If you do not set the planned receive capacity for one or more of the SCTP links associated with 
the linkset, then NoCap appears in the field.

Long Term Receive 
Utilization 
or
Long Term Receive 
Erlangs

Long-term average Receive for the linkset, expressed as a percentage or number of Erlangs (E) 
(as set with the mwtm webutil command), since MWTM polling began for the linkset, or since 
the MWTM last reset the averages as a result of bad data.

If you do not set the planned receive capacity for one or more of the SCTP links associated with 
the linkset, then NoCap appears in the field.

Field or Column Description

Field or Column Description

Node Name of the node for the linkset.

Signaling Point Name of the signaling point for the linkset.

Linkset Linkset for the object.

Average Average Send or Receive for the linkset for the specified time.

Minimum Minimum Send or Receive for the specified time.

Minimum Timestamp (timezone) Timestamp when the minimum value occurred.
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Daily Linkset Peaks Reports

You can view a daily linkset statistics peaks report using the Linkset Peaks Daily Report page. The peaks 
report shows peak values for each day and the hour in which each peak value occurred.

The Linkset Peaks Daily Report table is sorted based on the information in the Peak Send  or Peak Send 
Erlangs column. However, you can sort the table based on the information in one of the other columns 
(see Navigating Table Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Field or Column Description

Graph

Expand to Full Screen If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier 
viewing.

Utilization Percentage If Output Type is Graph, the Y-axis label shows daily linkset statistics over time.

Time If Output Type is Graph, the X-axis label shows a historical time scale and the server time zone.

Legend If Output Type is Graph, a color-coded legend shows labels for utilization.

Table, CSV

Date Date of the report.

Node Name of the node for the linkset.

SP Name Name of the signaling point for the linkset.

Linkset Name Linkset for the object.

Daily In-Service Percentage of time the linkset was in service on the specified date.

Long Term In-Service Average percentage of time the linkset was in service since MWTM polling began for the linkset, 
or since the MWTM last reset the averages as a result of bad data.

Daily Low In-Service Lowest hourly in-service percentage for the linkset for the specified date.

Low Service Hour Hour in which the lowest in-service percentage occurred for the specified date.

Average Utilization Average Send or Receive for the linkset, expressed as a percentage or number of Erlangs (E) (as 
set with the mwtm webutil command) for the specified date and hour.

If you do not set the planned receive capacity for one or more of the SCTP links associated with 
the linkset, then NoCap appears in the field.

Peak Utilization Highest Send or Receive for the linkset, expressed as a percentage or number of Erlangs (E) (as 
set with the mwtm webutil command) for the specified date and hour.

Peak Hour Hour in which the Peak Send or Peak Receive for the linkset occurred for the specified date. 

Click the hour to see the Link Hourly Report for all links associated with the chosen linkset for 
the chosen hour.

Long Term Average 
Utilization

Long-term average Send or Receive for the linkset, expressed as a percentage or number of 
Erlangs (E) (as set with the mwtm webutil command), since MWTM polling began for the 
linkset, or since the MWTM last reset the averages as a result of bad data.

If you do not set the planned send capacity for one or more of the SCTP links associated with the 
linkset, then NoCap appears in the field.
13-32
User Guide for the Cisco Mobile Wireless Transport Manager 6.1.1

OL-13314-01



 

Chapter 13      Managing Reports
  Viewing Reports
Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > Linkset.

Step 2 In the tool bar of the right pane, from the Type drop-down menu, select Linkset Peaks Daily Statistics. 
(See Table 13-1 for a list of report types and their contents).

Step 3 Choose a time range from the Duration drop-down menu or customize your own time range by clicking 
the Customize icon .

Step 4 Choose an output format (Graph, Table, or CSV) from the Output drop-down menu (see Table 13-1 for 
contents of each output type).

The Send Utilization and Receive Utilization tables contain summary information as described below:

Depending on what you select from the Output pulldown menu, the following information is displayed:

Field or Column Description

Node Name of the node for the linkset.

Signaling Point Name of the signaling point for the linkset.

Linkset Linkset for the object.

Average Average Send or Receive for the linkset for the specified time.

Minimum Minimum Send or Receive for the specified time.

Minimum Timestamp (timezone) Timestamp when the minimum value occurred.

Maximum Maximum Send or Receive for the specified time.

Maximum Timestamp (timezone) Timestamp when the maximum value occurred.

Field or Column Description

Graph

Expand to Full Screen If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier 
viewing.

Utilization Percentage If Output Type is Graph, the Y-axis label shows daily linkset statistics over time.

Time If Output Type is Graph, the X-axis label shows a historical time scale and the server time zone.

Legend If Output Type is Graph, a color-coded legend shows labels for utilization.

Table, CSV

Date Date of the report.

Node Name of the node for the linkset.

SP Name Name of the signaling point for the linkset.

Linkset Name Linkset for the object.

Peak Utilization Highest Send or Receive for the linkset, expressed as a percentage or number of Erlangs (E) (as 
set with the mwtm webutil command) for the specified date and hour.
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MLR Reports

Multi-Layer SMS Routing, or MLR, is a routing scheme that enables intelligent routing of Short 
Message Service (SMS) mobile originated (MO) messages based on the application or service from 
which they originated or to which they are destined. The MLR feature can make SMS message routing 
decisions based on information found in the TCAP, MAP, and MAP-user layers; MAP operation codes 
MAP-MT-FORWARD-SM and SEND-ROUTING-INFO-FOR-SM; and ANSI TCAP and IS-41 MAP 
operations.

You can view a summary report of daily statistics for MLR. You can also export the reports.

Daily MLR Reports

You can view a summary report of MLR processed, aborts, continues, result invokes, rule matches, 
subtriggers, and triggers statistics for the MWTM on a specified date. The MLR type Daily Report page 
shows reports of all archived MWTM daily MLR processed, aborts, continues, result invokes, rule 
matches, subtriggers, and triggers by date.

These archived daily MLR reports are available:

• Daily MLR Aborts Reports, page 13-34

• Daily MLR Continues Reports, page 13-35

• Daily MLR Processed Reports, page 13-36

• Daily MLR Result Invokes Reports, page 13-36

• Daily MLR RuleMatches Reports, page 13-37

• Daily MLR SubTriggers Reports, page 13-37

• Daily MLR Triggers Reports, page 13-38

Daily MLR Aborts Reports

The MLR Aborts Daily Report table is sorted based on the information in the Total Aborted column. 
However, you can sort the table based on the information in one of the columns (see Navigating Table 
Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Peak Hour Hour in which the Peak Send or Peak Receive for the linkset occurred for the specified date. 

Click the hour to see the Link Hourly Report for all links associated with the chosen linkset for 
the chosen hour.

Long Term Average 
Utilization

Long-term average Send or Receive for the linkset, expressed as a percentage or number of 
Erlangs (E) (as set with the mwtm webutil command), since MWTM polling began for the 
linkset, or since the MWTM last reset the averages as a result of bad data.

If you do not set the planned send capacity for one or more of the SCTP links associated with the 
linkset, then NoCap appears in the field.

Field or Column Description
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Daily MLR Continues Reports

The MLR Continues Daily Report table is sorted based on the information in the Total Continued 
column. However, you can sort the table based on the information in one of the columns (see Navigating 
Table Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Field or Column Description

Date Date of the report.

Node Name of the node for the signaling point.

Network Name Name of the network for the signaling point.

Signaling Point Name of the signaling point.

Total Aborted Total number of MSUs aborted by MLR on the specified date.

No Resources Number of MSUs aborted by MLR because of a shortage of resources on the specified date.

Results Blocked Number of MSUs aborted by MLR with a result of block on the specified date.

GTI Mismatches Number of MSUs aborted by MLR because of mis-matched GTIs on the specified date.

Addr Conv Fails Number of MSUs aborted by MLR because of a failed GTA address conversion on the specified 
date.

Dest Unavails Number of MSUs aborted by MLR because the destination was unavailable on the specified date.

No Server Aborteds Number of MSUs aborted by MLR because no server was available on the specified date.

Field or Column Description

Date Date of the report.

Node Name of the node for the signaling point.

Network Name Name of the network for the signaling point.

Signaling Point Name of the signaling point.

Total Continued Total number of MSUs returned to SCCP by MLR with a result of continue on the specified 
date.

Unsupported Message Type Number of MSUs returned to SCCP by MLR because of unsupported message types on the 
specified date.

Unsupported Seg SCCP Number of MSUs returned to SCCP by MLR because of unsupported SCCP segments on the 
specified date.

Unsupported Messages Number of MSUs returned to SCCP by MLR because of parse failures resulting from 
unsupported messages on the specified date.

Parse Errors Number of MSUs returned to SCCP by MLR because of parse errors on the specified date.

No Results Number of MSUs returned to SCCP by MLR with no results on the specified date.

Result Continueds Number of MSUs returned to SCCP by MLR with a result of continue on the specified date.
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Daily MLR Processed Reports

The MLR Processed Daily Report table is sorted based on the information in the Routed column. 
However, you can sort the table based on the information in one of the columns (see Navigating Table 
Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Daily MLR Result Invokes Reports

The MLR Result Invokes Daily Report table is sorted based on the information in the Invokes column. 
However, you can sort the table based on the information in one of the columns (see Navigating Table 
Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

No Server Continueds Number of MSUs returned to SCCP by MLR because no server was available on the specified 
date.

Result GTTs Number of MSUs returned to SCCP by MLR with a result of GTT on the specified date.

Failed Triggers Number of MSUs returned to SCCP by MLR because of no trigger match on the specified date.

Field or Column Description

Field or Column Description

Date Date of the report.

Node Name of the node for the signaling point.

Network Name Name of the network for the signaling point.

Signaling Point Name of the signaling point.

Routed Total number of packets routed by MLR on the specified date.

Total Continued Total number of MSUs passed back to SCCP processing by MLR on the specified date.

Total Aborted Total number of MSUs not processed by MLR because of invalid data or a blocked MSU.

MAP SMS-MOs Number of MSUs of type GSM-MAP SMS-MO processed by MLR on the specified date.

MAP SMS-MTs Number of MSUs of type GSM-MAP SMS-MT processed by MLR on the specified date.

MAP SRI-SMs Number of MSUs of type GSM-MAP SRI-SM processed by MLR on the specified date.

MAP AlertScs Number of MSUs of type GSM-MAP AlertSc processed by MLR on the specified date.

ANSI-41 SMD-PPs Number of MSUs of type ANSI-41 SMD-PP processed by MLR on the specified date.

ANSI-41 SMS-Requests Number of MSUs of type ANSI-41 SMSRequest processed by MLR on the specified date.

ANSI-41 SMS-Notifys Number of MSUs of type ANSI-41 SMSNotify processed by MLR on the specified date.

Links Contains links to related MLR reports (Aborts, Continues, Triggers, SubTriggers, RuleMatches, 
and ResultInvokes). The target report is filtered by the signaling point. 
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Daily MLR RuleMatches Reports

The MLR RuleMatches Daily Report table is sorted based on the information in the Matches column. 
However, you can sort the table based on the information in one of the columns (see Navigating Table 
Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Daily MLR SubTriggers Reports

The MLR SubTriggers Daily Report table is sorted based on the information in the Matches column. 
However, you can sort the table based on the information in one of the columns (see Navigating Table 
Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Field or Column Description

Date Date of the report.

Node Name of the node for the signaling point.

Network Name Name of the network for the signaling point.

Signaling Point Name of the signaling point.

ResultSet Name of the result set of which this result is a member.

Result Number Number of this result in the result set.

Invokes Total number of times this result was invoked.

Field or Column Description

Date Date of the report.

Node Name of the node for the signaling point.

Network Name Name of the network for the signaling point.

Signaling Point Name of the signaling point.

RuleSet Name of the rule set of which this rule is a member.

Rule Number Number of this rule in the rule set.

Matches Total number of times this rule was matched.

Field or Column Description

Date Date of the report.

Node Name of the node for the signaling point.

Network Name Name of the network for the signaling point.
13-37
User Guide for the Cisco Mobile Wireless Transport Manager 6.1.1

OL-13314-01



 

Chapter 13      Managing Reports
  Viewing Reports
Daily MLR Triggers Reports

The MLR Triggers Daily Report table is sorted based on the information in the Matches column. 
However, you can sort the table based on the information in one of the columns (see Navigating Table 
Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

MSU Rates Reports

You can view 15 minute, hourly and daily MSU rates reports. You can also export the reports in CSV 
format. 

This section covers:

• MSU Load Reports, page 13-39

• MSU Peaks Reports, page 13-39

Signaling Point Name of the signaling point.

Trigger Index Index number associated with the trigger.

Sub Trigger Index Index number associated with the subtrigger.

Action Action taken by the subtrigger. Clicking on the ruleset name highlights the 
signaling point in the navigation tree and opens the MLR Trigger Config tab for 
the chosen ruleset.

Parameters Parameters that control the behavior of the subtrigger.

Matches Number of subtrigger matches with result Action Performed.

Field or Column Description

Field or Column Description

Date Date of the report.

Node Name of the node for the signaling point.

Network Name Name of the network for the signaling point.

Signaling Point Name of the signaling point.

Trigger Index Index number associated with the trigger.

Action Action taken by the trigger. Clicking on the ruleset name highlights the 
signaling point in the navigation tree and opens the MLR Trigger Config tab 
for the chosen ruleset.

Parameters Parameters that control the behavior of the trigger.

Preliminary Matches Preliminary count of trigger matches.

Matches Number of trigger matches with result Action Performed.

Links Contains links to related MLR SubTrigger reports. The target report is filtered 
by the signaling point. 
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MSU Load Reports

You can view a 15 minute, hourly, or daily report of MSU load rates for all nodes that the MWTM 
detected in that time. The MSU Load Report provides the distribution of send and receive MSU packets, 
pertaining to overload thresholds for every CPU. 

The MSU Load Report tables are sorted based on the information in the Date column. However, you can 
sort the tables based on the information in one of the columns (see Navigating Table Columns, 
page 5-22).

MSU Peaks Reports

You can view a 15 minute, hourly, or daily report of MSU peak rates for all nodes that the MWTM 
detected in that time. The MSU Peaks Report page provides information that helps you analyze the 
maximum send and receive rates for each processor in MSU units per second. 

The MSU Peaks Report tables are sorted based on the information in the Send column. However, you 
can sort the tables based on the information in one of the columns (see Navigating Table Columns, 
page 5-22).

Field or Column Description

Date Date of the report.

Node Name of the node.

Processor /Bay Number of the processor and the number of the bay containing the processor. 
This number is set to zero when the platform does not support processors in 
multiple slots or bays.

Overloaded Threshold Over this rate of traffic, MSU traffic handling may be impacted.

Duration % Send Duration of time the send MSU rate is in the specified percentage.

Duration % Receive Duration in time the receive MSU rate is in the specified percentage.

Field or Column Description

Date Date of the report.

Node Name of the node.

Processor /Bay Number of the processor and the number of the bay containing the processor. This number is set 
to zero when the platform does not support processors in multiple slots or bays.

Max Rate (MSU/sec) Send This value records the highest rate of MSUs per second sent by the processor since the 
measurement was cleared.

Max Rate (MSU/sec) 
Receive

This value records the highest rate of MSU per second received by the processor since the 
measurement was cleared.

Threshold (MSU/sec) 
Acceptable

Specifies a level of traffic below which traffic is considered to be acceptable. Once the traffic rate 
exceeds the Warning threshold, it is not Acceptable until traffic falls below this threshold.

Threshold (MSU/sec) 
Warning

Specifies a level of traffic that should be avoided, but is below a level that impacts MSU routing. 
Once the traffic rate exceeds the Overloaded threshold, it is not considered non-impacting until 
the traffic falls below this threshold.

Threshold (MSU/sec) 
Overloaded

Specifies a level of traffic indicating a rate that might impact MSU routing. 
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RAN Reports

The MWTM web interface provides network-wide reports that summarize IP-RAN over a specified time 
period. The information is available in graphical, tabular, and CSV formats. Administrators use these 
reports for analysis of network-wide performance and errors for RAN backhauls and shorthauls. For 
example, you can generate a report to show which backhaul links were the most heavily utilized in the 
last 24 hours. Then you can drill down to a specific node for closer analysis, if necessary.

To generate a network-wide RAN report:

Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > RAN.

Step 2 In the tool bar of the right pane, choose a report type from the Type drop-down menu (see Table 13-1 for 
a list of report types and their contents).

Step 3 Choose a time range from the Duration drop-down menu or customize your own time range by clicking 
the Customize icon .

Step 4 Choose an output format (Graph, Table, or CSV) from the Output drop-down menu (see Table 13-1 for 
contents of each output type).

Note The Graph output displays up to twelve RAN data streams based on traffic and/or number of 
errors. To view all RAN data streams, choose Table or CSV.

Step 5 To generate the report, click the Run icon (green arrow ). 

Step 6 To understand the report, click the report type listed in Table 13-1 for a detailed description of the report 
fields.

Note All of the following report types, except for PWE3 reports, are supported for RAN-O based 
deployments only.

Duration in Acceptable 
Threshold (minutes) Send

Rate of traffic (in seconds) sent by this processor considered as acceptable.

Duration in Acceptable 
Threshold (minutes) 
Receive

Rate of traffic (in seconds) received by this processor considered as acceptable.

Duration in Warning 
Threshold (minutes) Send

Rate of traffic (in seconds) sent by this processor considered above the acceptable level and below 
a level that impacts MSU routing.

Duration in Warning 
Threshold (minutes) 
Receive

Rate of traffic (in seconds) received by this processor considered above the acceptable level and 
below a level that impacts MSU routing.

Duration in Overloaded 
Threshold (minutes) Send

Rate of traffic (in seconds) sent by this processor at a level that may impact MSU routing. 

Duration in Overloaded 
Threshold (minutes) 
Receive

Rate of traffic (in seconds) received by this processor at a level that may impact MSU routing. 

Field or Column Description
13-40
User Guide for the Cisco Mobile Wireless Transport Manager 6.1.1

OL-13314-01



 

Chapter 13      Managing Reports
  Viewing Reports
Report Type Output Contents

Backhaul 
Performance Daily

Graph Minimum, maximum, and average performance data for all the RAN backhauls in the 
network:

• Send Summary—Table summary of backhaul send data.

• Receive Summary—Table summary of backhaul receive data.

• Send Backhaul Performance Daily—Graph of backhaul send data.

• Receive Backhaul Performance Daily—Graph of backhaul receive data.

Table or 
CSV

Send and receive data, node, and backhaul in tabular format.

Backhaul Errors 
Daily

Graph For all the RAN backhauls in the network:

• Table—Average error rate, total errors, and total GSM-Abis and UMTS-Iub errors in 
tabular format.

• Backhaul Errors Daily—Graph that shows total errors, GSM errors, and UMTS errors.

Table or 
CSV

Tabular information that shows total errors, total GSM-Abis errors, total UMTS-Iub errors, 
node, and backhaul.

Shorthaul 
Performance Daily

Graph Minimum, maximum, and average performance data for all the RAN shorthauls in the 
network:

Send Summary—Table summary of shorthaul send data.

Receive Summary —Table summary of shorthaul receive data.

Send Shorthaul Performance Daily—Graph of shorthaul send data.

Receive Shorthaul Performance Daily—Graph of shorthaul receive data.

Table or 
CSV

Tabular information that shows send and receive data, protocol type, node, and shorthaul.

GSM Errors Daily Graph Table—Tabular data that shows total GSM error counts and average error rate over the 
chosen time period.

GSM Errors Daily—Graph of GSM errors over the chosen time period.

Table or 
CSV

Tabular information that shows total errors, total missed packets, total protocol errors, total 
miscellaneous errors, node, backhaul, and shorthaul.

UMTS Errors Daily Graph Table—Tabular data that shows total UMTS error counts and average error rate over the 
chosen time period.

UMTS Errors Daily—Graph of UMTS errors over the chosen time period.

Table or 
CSV

Tabular information that shows total errors, total protocol errors, total miscellaneous errors, 
node, backhaul, and shorthaul.

PWE3 Performance 
Daily

Table or 
CSV

Tabular information that shows send and receive data, packet rate, total packets, maximum, 
average, and minimum rate. 

Note This report is supported only on platforms running IPRAN with PWE3 data tunnels 
configured. PWE3 reports are not supported for RAN-O deployments.
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Backhaul Performance Daily

Output GUI Element Description

Graph Node Table column that lists nodes that contain RAN backhauls. To access details for a specific 
node, click a node in this column.

Backhaul Table column that lists the visible backhauls. To access details for a specific backhaul, click 
a backhaul in this column.

Note The column shows a maximum of 12 backhauls by default. To change the number of 
visible backhauls, use the Graph Series Editor. See Using the Toolbar, page 11-5, for 
more information.

Average Utilization Table column that shows the average of the backhaul. A value greater than 100% indicates 
that the backhaul is oversubscribed. 

Average Table column that shows average bits per second for the backhaul.

Minimum Utilization Table column that shows the minimum of the backhaul. A value greater than 100% indicates 
that the backhaul is oversubscribed. 

Minimum Table column that shows minimum number of bits per second for the backhaul.

Minimum Timestamp Table column that shows time when the minimum bits-per-second value occurred.

Maximum Utilization Table column that shows the maximum of the backhaul. A value greater than 100% indicates 
that the backhaul is oversubscribed. 

Maximum Table column that shows maximum number of bits per second for the backhaul.

Maximum Timestamp Table column that shows time when the maximum bits-per-second value occurred.

Expand to Full Screen Click this link to open the graph in a full-screen window for better viewing.

Minimum Bits (or 
Bytes)/Sec

Y-axis labels for graphs that show minimum, average, and maximum bits per second for the 
visible backhauls.

Note The graph shows a maximum of 12 backhauls by default. To change the number of 
visible backhauls, use the Graph Series Editor. See Using the Toolbar, page 11-5, for 
more information.

Average Bits (or 
Bytes)/Sec

Maximum Bits (or 
Bytes)/Sec

Legend Appearing below each graph, a legend of color-coded labels for each backhaul that appears 
in the graph.

Table, 
CSV

Node Table column that lists all network nodes that contain backhauls. If Output is Table, to access 
performance details for a specific node, click a node in this column.

Backhaul Table column that lists all the backhauls in the network. If Output is Table, to access 
performance details for a specific backhaul, click a backhaul in this column.

Errors Table column that shows total error counts for each backhaul.

Send Bits Table columns that show minimum, average, and maximum values and their timestamps for 
send traffic on the backhaul.

Receive Bits Table columns that show minimum, average, and maximum values and their timestamps for 
receive traffic on the backhaul.
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Backhaul Errors Daily

Output GUI Element Description

Graph Node Table column that lists nodes that contain RAN backhauls. To access details for a specific node, 
click a node in this column.

Backhaul Table column that lists the visible backhauls. To access details for a specific backhaul, click a 
backhaul in this column.

Note The graph shows a maximum of 12 backhauls by default. To change the number of visible 
backhauls, use the Graph Series Editor. See Using the Toolbar, page 11-5, for more 
information.

Avg. Error 
Rate (Per Sec)

Table column that lists the average error rate each second for the visible backhauls.

Total Errors Table column that lists the total number of errors (GSM and UMTS) for each visible backhaul.

Total Errors 
GSM-Abis

Table column that lists the total number of GSM-Abis errors for each visible backhaul.

Total Errors 
UMTS-Iub

Table column that lists the total number of UMST-Iub errors for each visible backhaul.

Expand to Full 
Screen

Click this link to open the graph in a full-screen window for better viewing.

UMTS Errors Y-axis labels for graphs that show total UMTS errors, total GSM errors, and a combined total of 
UMTS and GSM errors for the visible backhauls.

Note The graph shows a maximum of 12 backhauls by default. To change the number of visible 
backhauls, use the Graph Series Editor. See Using the Toolbar, page 11-5, for more 
information.

GSM Errors

Total Errors

Legend Positioned below the graph, a legend of color-coded labels for each backhaul that appears in the 
graph.

Table, 
CSV

Lists the same information as the graph output type, but in tabular format; also includes one unique field:

Timestamp—identifies the time that each error value occurred for each visible backhaul.
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Shorthaul Performance Daily

Output GUI Element Description

Graph Node Table column that lists nodes that contain RAN shorthauls. To access details for a specific node, click 
a node in this column.

Backhaul Table column that lists the visible backhauls. To access details for a specific backhaul, click a 
backhaul in this column.

Shorthaul Table column that lists the visible shorthauls. To access details for a specific shorthaul, click a 
shorthaul in this column.

Note The graph shows a maximum of 12 shorthauls by default. To change the number of visible 
shorthauls, use the Graph Series Editor. See Using the Toolbar, page 11-5, for more 
information.

Average Table column that shows the average bits per second for the shorthaul.

Minimum Table column that shows the minimum number of bits per second for the shorthaul.

Minimum 
Timestamp

Table column that shows time when the minimum bits-per-second value occurred.

Maximum Table column that shows maximum number of bits per second for the shorthaul.

Maximum 
Timestamp

Table column that shows time when the maximum bits-per-second value occurred.

Expand to 
Full Screen

Click this link to open the graph in a full-screen window for better viewing.

Minimum 
Bits (or 
Bytes)/Sec

Y-axis labels for graphs that show minimum, average, and maximum bits per second for the visible 
shorthauls.

Note The graph shows a maximum of 12 shorthauls by default. To change the number of visible 
shorthauls, use the Graph Series Editor. See Using the Toolbar, page 11-5, for more 
information.

Average Bits 
(or Bytes)/Sec

Maximum 
Bits (or 
Bytes)/Sec

Legend Positioned below each graph, a legend of color-coded labels for each shorthaul that appears in the 
graph.

Table, 
CSV

Node Table column that lists all the nodes that contain RAN backhauls. If Output is Table, to access details 
for a specific node, click a node in this column.

Backhaul Table column that lists all the RAN backhauls in the network. If Output is Table, to access details for 
a specific backhaul, click a backhaul in this column.

Shorthaul Table column that lists all the RAN shorthauls in the network. If Output is Table, to access details 
for a specific shorthaul, click a shorthaul in this column.

Protocol Table column that shows whether the shorthaul protocol is GSM or UMTS.

Send Bits Table columns that show minimum, average, and maximum values and their timestamps for send 
traffic on the shorthaul.

Receive Bits Table columns that show minimum, average, and maximum values and their timestamps for receive 
traffic on the shorthaul.
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GSM Errors Daily

Output GUI Element Description

Graph Node Table column that lists nodes that contain GSM shorthauls. To access details for a specific node, 
click a node in this column.

Backhaul Table column that lists backhauls that contain GSM shorthauls. To access details for a specific 
backhaul, click a backhaul in this column.

Shorthaul Table column that lists the visible GSM shorthauls. To access details for a specific shorthaul, click 
a shorthaul in this column.

Note The table shows a maximum of 12 shorthauls by default. To change the number of visible 
shorthauls, use the Graph Series Editor. See Using the Toolbar, page 11-5, for more 
information.

Total Counts Table column that lists the total number of GSM errors for the visible shorthauls during the chosen 
duration.

Avg. Error Rate 
(Per Sec)

Table column that lists the average error rate each second for the visible shorthauls.

Expand to Full 
Screen

Click this link to open the graph in a full-screen window for better viewing.

Error Counts Y-axis label for graph that shows total GSM errors for the visible GSM shorthauls.

Note The graph shows a maximum of 12 shorthauls by default. To change the number of visible 
shorthauls, use the Graph Series Editor. See Using the Toolbar, page 11-5, for more 
information.

Legend Positioned below the graph, a legend of color-coded labels for each shorthaul that appears in the 
graph.

Table, 
CSV

Node Table column that lists all the nodes that contain GSM shorthauls. If Output is Table, to access 
details for a specific node, click a node in this column.

Backhaul Table column that lists all the backhauls that contain GSM shorthauls. If Output is Table, to access 
details for a specific backhaul, click a backhaul in this column.

Shorthaul Table column that lists all the GSM shorthauls in the network. If Output is Table, to access details 
for a specific shorthaul, click a shorthaul in this column.

Total Errors Table column that lists the total number of GSM errors for the visible shorthauls during the chosen 
duration.

Total Missed 
Packets

Total number of missed packets on the GSM shorthaul.

Total Protocol 
Errors

Total number of protocol errors on the GSM shorthaul.

Total 
Miscellaneous 
Errors

Total number of miscellaneous errors on the GSM shorthaul.
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UMTS Errors Daily

Output GUI Element Description

Graph Node Table column that lists nodes that contain UMTS shorthauls. To access details for a specific node, 
click a node in this column.

Backhaul Table column that lists backhauls that contain UMTS shorthauls. To access details for a specific 
backhaul, click a backhaul in this column.

Shorthaul Table column that lists the visible UMTS shorthauls. To access details for a specific shorthaul, click 
a shorthaul in this column.

Note The table shows only 12 shorthauls by default. To change the number of visible shorthauls, 
use the Graph Series Editor. See Using the Toolbar, page 11-5, for more information.

Total Counts Table column that lists the total number of UMTS errors that occurred for the visible shorthauls 
during the chosen duration.

Avg. Error 
Rate (Per Sec)

Table column that lists the average error rate each second for the visible shorthauls during the 
chosen duration.

Expand to Full 
Screen

Click this link to open the graph in a full-screen window for better viewing.

Error Counts Y-axis label for the graph that shows the total number of UMTS errors for the visible UMTS 
shorthauls.

Note The graph shows only 12 shorthauls by default. To change the number of visible shorthauls, 
use the Graph Series Editor. See Using the Toolbar, page 11-5, for more information.

Legend Positioned below the graph, a legend of color-coded labels for each UMTS shorthaul that appears 
in the graph.

Table, 
CSV

Node Table column that lists nodes that contain UMTS shorthauls. If Output is Table, to access details for 
a specific node, click a node in this column.

Backhaul Table column that lists all the backhauls that contain UMTS shorthauls. If Output is Table, to access 
details for a specific backhaul, click a backhaul in this column.

Shorthaul Table column that lists all the UMTS shorthauls in the network. If Output is Table, to access details 
for a specific shorthaul, click a shorthaul in this column.

Timestamp Time that the error values occurred for the visible shorthauls.

Total Errors Table column that lists the total number of UMTS errors for the visible shorthauls during the chosen 
duration.

Total Protocol 
Errors

Table column that lists the total number of protocol errors on the UMTS shorthaul.

Total 
Miscellaneous 
Errors

Table column that lists the total number of miscellaneous errors on the UMTS shorthaul.
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PWE3 Performance Daily

SCTP Reports

The MWTM web interface provides node-level SCTP reports for performance and error statistics. The 
information is available in graphical, tabular, and CSV formats.

Note SCTP Reports are supported on ITP platforms only.

To generate a network-wide SCTP report:

Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > SCTP. You 
can also click on a node name, then select the Reports tab.

Step 2 In the tool bar of the right pane, choose a report type from the Type drop-down menu:

Output GUI Element Description

Table, 
CSV

Node Name of the node for the virtual circuit

ID Virtual circuit ID

Timestamp 
(timezone)

Timestamp for traffic received.

Receive Bits Packet Count Number of packets received.

Packet Max 
Rate

Maximum packet rate for traffic received.

Packet Avg 
Rate

Average packet rate for traffic received.

Packet Min 
Rate

Minimum packet rate for traffic received.

Total Total bytes received 

Max Rate Maximum bytes/second received

Avg Rate Average bytes/second received

Min Rate Minimum bytes/second received 

Sent Bits Packet Count Number of packets sent.

Packet Max 
Rate

Maximum packet rate for traffic sent.

Packet Avg 
Rate

Average packet rate for traffic sent.

Packet Min 
Rate

Minimum packet rate for traffic sent.

Total Total bytes sent 

Max Rate Maximum bytes/second sent

Avg Rate Average bytes/second sent

Min Rate Minimum bytes/second sent
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• SCTP Performance Reports, page 13-48

• SCTP Errors Reports, page 13-49

Note The 15-minute and hourly reports for SCTP are available from the node level only; they are not 
available from the top level or the network level. 

SCTP Performance Reports

MWTM displays the SCTP performance rates obtained during the specified period (for example, 15 
minutes, hourly, daily).

Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > SCTP.

Step 2 In the tool bar of the right pane, from the Type drop-down menu, select an SCTP Performance report:

• SCTP Performance 15 Minutes

• SCTP Performance Hourly

• SCTP Performance Daily

Note The 15-minute and hourly reports for SCTP are available from the node level only; they are not 
available from the top level or the network level. Click on a node name in the SCTP reports to 
navigate to a specific node to view hourly and 15 minute reports for that node.

Step 3 From the toolbar, select the duration and output type. See Using the Toolbar, page 11-5.

The Send and Receive Summary for SCTP Packets displays the following information:

Depending on what output type you selected, the following information is displayed:

Field or Column Description

Node. You can click on a node name to go to node-specific reports.

Send Average Packets Average SCTP packets sent.

Maximum Packets Maximum SCTP packets sent.

Maximum Timestamp 
(timezone)

Time when the maximum SCTP packets sent value occurred.

Receive Average Packets Average SCTP packets received.

Maximum Packets Maximum SCTP packets received.

Maximum Timestamp 
(timezone)

Time when the maximum SCTP packets received value 
occurred.
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SCTP Errors Reports

MWTM displays the SCTP error rates obtained during the specified period (for example, 15 minutes, 
hourly, daily).

Step 1 In the left pane (navigation tree) of the MWTM web interface, choose Reports > Statistics > SCTP.

Step 2 In the tool bar of the right pane, from the Type drop-down menu, select an SCTP Errors report:

• SCTP Errors 15 Minutes

• SCTP Errors Hourly

• SCTP Errors Daily

GUI Element Description

Graph If you select Graph from the Output menu, the graph displays the SCTP send and receive packets rates 
over the specified time period.

Table If you select Table from the Output menu, the table contains:

• Node

• Timestamp (timezone)—Timestamp of the report.

• Send

– SCTP Packets—Number of SCTP packets sent to peers.

– Control Chunks—Number of SCTP control chunks sent to peers (no transmissions included).

– Ordered Chunks—Number of SCTP ordered data chunks sent to peers (no transmissions 
included).

– Unordered Chunks—Number of SCTP unordered chunks (which are data chunks in which the U 
bit is set to one) sent to peers (no transmissions included).

• Receive

– SCTP Packets—Number of SCTP packets received from peers.

– Control Chunks—Number of SCTP control chunks received from peers (no transmissions 
included).

– Ordered Chunks—Number of SCTP ordered data chunks received from peers (no transmissions 
included).

– Unordered Chunks—Number of SCTP unordered chunks (which are data chunks in which the U 
bit is set to one) received from peers (no transmissions included).

Expand to Full 
Screen

If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier viewing.

Percentage 
Utilization

If Output Type is Graph, the Y-axis label shows percentage of utilization over time.

Time If Output Type is Graph, the X-axis label shows a historical time scale and the server time zone.

Legend If Output Type is Graph, a color-coded legend shows labels for utilization.
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Note The 15-minute and hourly reports for SCTP are available from the node level only; they are not 
available from the top level or the network level. Click on a node name in the SCTP reports to 
navigate to a specific node to view hourly and 15 minute reports for that node.

Step 3 From the toolbar, select the duration and output type. See Using the Toolbar, page 11-5.

The Errors Summary for SCTP Packets displays the following information:

Depending on what output type you selected, the following information is displayed:

Field or Column Description

Unassociated Packets Number of SCTP packets received by the host which are correctly formed but for which the receiver 
is not able to identify the association to which the packet belongs.

Checksum Errors Number of SCTP packets received from peers with an invalid checksum.

Fragmented User 
Messages

Number of user messages that have to be fragmented because of the MTU.

Reassembled User 
Messages

Number of user messages reassembled.

Retransmitted Chunks Number of SCTP chunks retransmitted due to the T3 timers expiring before the packet is 
acknowledged.

Retransmitted Chunks 
(Fast Recovery)

Number of SCTP chunks retransmitted using the fast-recovery retransmission mechanism specified 
in SCTP.

Destination Address 
Failures

Number of times a destination IP address was marked unavailable since the start of the association. 
The IP destination address will be marked unavailable when the specified number of 
retransmissions have failed.
13-50
User Guide for the Cisco Mobile Wireless Transport Manager 6.1.1

OL-13314-01



 

Chapter 13      Managing Reports
  Viewing Reports
Generating Node-Level CPU/Memory Reports

In addition to generating network-wide CPU/Memory reports as explained in CPU/Memory Reports, 
page 13-13, you can also generate node-level CPU/Memory reports as explained in the following steps.

Step 1 From the MWTM web interface, click on a node name.

Step 2 Click the Performance tab.

Step 3 From the View pulldown menu, select Historical CPU Utilization or Historical Memory Utilization. 

If the device you selected has multiple CPUs, in addition to the Summary tab, there are also separate Slot 
tabs. Each Slot tab contains CPU statistics for the CPUs in that slot.

Step 4 From the Type menu, select which CPU or Memory report to view:

GUI Element Description

Graph If you select Graph from the Output menu, the graph displays the SCTP error packets rates over the 
specified time period.

Note The Graph option is available when you generate a report for a specific node only. You cannot 
generate a graph for SCTP errors at the network level.

Table If you select Table from the Output menu, the table contains:

• Timestamp (timezone)—Timestamp of the report.

• Node—Name of the node.

• Unassociated Packets—Number of SCTP packets received by the host which are correctly formed but 
for which the receiver is not able to identify the association to which the packet belongs.

• Checksum Errors—Number of SCTP packets received from peers with an invalid checksum.

• Fragmented User Messages—Number of user messages that have to be fragmented because of the 
MTU.

• Reassembled User Messages—Number of user messages reassembled

• Retransmitted Chunks—Number of SCTP chunks retransmitted due to the T3 timers expiring before 
the packet is acknowledged.

• Retransmitted Chucks (Fast Recovery)—Number of SCTP chunks retransmitted using the 
fast-recovery retransmission mechanism specified in SCTP.

• Destination Address Failures— Number of times a destination IP address was marked unavailable 
since the start of the association. The IP destination address will be marked unavailable when the 
specified number of retransmissions have failed.

Expand to Full 
Screen

If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier viewing.

Percentage 
Utilization

If Output Type is Graph, the Y-axis label shows percentage of CPU utilization over time.

Time If Output Type is Graph, the X-axis label shows a historical time scale and the server time zone.

Legend If Output Type is Graph, a color-coded legend shows labels for utilization.
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• CPU Peak Utilization 15 Minutes

• CPU Average Utilization 15 Minutes

• CPU Peak Utilization Hourly

• CPU Average Utilization Hourly

• CPU Peak Utilization Daily

• CPU Average Utilization Daily

• Memory Peak Utilization 15 Minutes

• Memory Average Utilization 15 Minutes

• Memory Peak Utilization Hourly

• Memory Average Utilization Hourly

• Memory Peak Utilization Daily

• Memory Average Utilization Daily

Viewing Accounting Reports
You can view any of the following statistics reports:

• AS/ASP Accounting Reports, page 13-52

• GTT Accounting Reports, page 13-53

• MTP3 Accounting Reports, page 13-54

Note All accounting reports are supported on ITP platforms only.

AS/ASP Accounting Reports

You can view daily reports for application server (AS) and application server process (ASP) accounting 
statistics by using the MWTM. You can also export the report. AS/ASP accounting describes MTP3 layer 
traffic in support of application servers. 

Field or Column Description

Date Date of the report.

Node Name of the node for the linkset.

Network Name Name of the network for the linkset.

Signaling Point Name of the signaling point for the linkset.

AS Name of the application server.

OPC Originating point code of the traffic, which is a unique identifier for each set of statistics.

To see only statistics that match a specific OPC for a given linkset, find the linkset and click the point 
code.
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GTT Accounting Reports

You can view summary reports of daily GTT accounting statistics. You can also export the reports. 

GTT Accounting Statistics Daily Summary Reports

You can view a daily summary of GTT accounting statistics for all nodes that the MWTM detected on a 
specified date. The GTT Accounting Daily Report page shows all MWTM daily GTT accounting 
statistics detail reports by date. Each file contains a daily summary of GTT accounting statistics for all 
nodes that the MWTM detected on a specified date.

The GTT Accounting Daily Report table is sorted based on the information in the Packets column. 
However, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

DPC Destination point code of the traffic.

To see only statistics that match a specific DPC for a given linkset, find the linkset and click the point 
code.

SI Service indicator, which indicates the type of Signaling System 7 (SS7) traffic. Valid values include:

• 0—Signaling Network Management Message (SNM)

• 1—Maintenance Regular Message (MTN) 

• 2—Maintenance Special Message (MTNS)

• 3—Signaling Connection Control Part (SCCP)

• 4—Telephone User Part (TUP)

• 5—ISDN User Part (ISUP)

• 6—Data User Part (call and circuit-related messages)

• 7—Data User Part (facility registration/cancellation messages)

To see only more information for a specific type of SI, click the SI type.

Send MSUs Total number of MTP3 MSUs sent on the specified date.

Receive MSUs Total number of MTP3 MSUs received on the specified date.

Send Bytes Total number of bytes sent on the specified date.

Receive Bytes Total number of bytes received on the specified date.

Field or Column Description

Field or Column Description

Date Date of the report.

Node Name of the node associated with the From Network Name for which data is visible.

From Network Name Name of the network from which GTT traffic originated, and for which data is visible.
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MTP3 Accounting Reports

MTP3 accounting describes MTP3 layer traffic in support of linksets. You can also export the MTP3 
accounting reports. 

Note Every five minutes (by default), the ITP moves data records from a quick-access table to a database that 
stores long term accounting records. This database contains accumulated accounting data since the last 
clearing or from the time accounting was originally enabled. The MWTM shows only the data from this 
database, not from the quick-access table.

MTP3 Accounting Statistics Daily Detail Reports

You can view a daily summary of MTP3 accounting statistics for the MWTM on a specified date. The 
MTP3 Accounting Daily Report page shows detail reports of all MWTM daily MTP3 accounting 
statistics by date. Each file contains a daily summary of MTP3 accounting statistics for the MWTM on 
a specified date.

The MTP3 Accounting Daily Report table is sorted based on the information in the Send MSUs column. 
However, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-22).

Note If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Signaling Point Name of the signaling point associated with the From Network Name instance for which data 
is visible.

Linkset Name of the linkset associated with the From Network Name instance for which data is visible.

Selector Name of the selector.

GTA Global Title Address (GTA) associated with the selector.

To Network Name Name of the network in which the translated point code resides.

Point Code Destination point code for the GTA.

Packets Total number of packets requiring translation by GTT on the specified date.

Octets Total number of octets requiring translation by GTT on the specified date.

Field or Column Description

Field or Column Description

Date Date of the report.

Node Name of the node for the linkset.

Network Name Name of the network for the linkset.

Signaling Point Name of the signaling point for the linkset.

Linkset Name of the linkset.
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Viewing Subscriber Count Reports
You can view any of the following subscriber count reports:

• BWG Subscriber Count Reports, page 13-56

• CSG2 Subscriber Count Reports, page 13-57

• GGSN Subscriber Count Reports, page 13-58

• HA Subscriber Count Reports, page 13-59

Node Instance Counts in BWG and GGSN Subscriber Reports

When viewing BWG and GGSN subscriber reports, you might notice a discrepancy in the Node Instance 
column between the most recent record and older records. This occurs when the most recent record is 
not complete due to the differences in polling intervals of BWG and GGSN devices. Up to 6 BWG and 
GGSN IOS instances can run on a single SAMI card. MWTM sees each instance as a separate device 
and is not aware at the management level that different devices might run on the same physical card. As 
a result, the devices are polled and data is collected at different times during the regular polling interval. 

Gateway Screening Indicates whether the traffic passed or failed the Gateway Screening test at the ITP.

To see only statistics that passed or failed for a specific linkset, select a linkset and click Pass, Fail, 
or Unroutable.

OPC Originating point code of the traffic, which is a unique identifier for each set of statistics.

To see only statistics that match a specific OPC for a given linkset, find the linkset and click the point 
code.

DPC Destination point code of the traffic.

To see only statistics that match a specific DPC for a given linkset, find the linkset and click the point 
code.

SI Service indicator, which indicates the type of SS7 traffic. Valid values include:

• 0—Signaling Network Management Message (SNM) 

• 1—Maintenance Regular Message (MTN) 

• 2—Maintenance Special Message (MTNS) 

• 3—Signaling Connection Control Part (SCCP) 

• 4—Telephone User Part (TUP) 

• 5—ISDN User Part (ISUP) 

• 6—Data User Part (call and circuit-related messages) 

• 7—Data User Part (facility registration/cancellation messages)

To see only more information for a specific type of SI, click the SI type.

Send MSUs Total number of MTP3 MSUs sent on the specified date.

Receive MSUs Total number of MTP3 MSUs received on the specified date.

Send Bytes Total number of bytes sent on the specified date.

Receive Bytes Total number of bytes received on the specified date.

Field or Column Description
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For example, GGSN A on SAMI 1 is polled at 12:01 p.m. and GGSN B on SAMI 1 is polled at 12:14 p.m. 
during a regular 15-minute polling interval. When you view the latest report data for reports that 
aggregate data at the SAMI card level, such as subscriber reports, there are discrepancies. The subscriber 
report is a card- level report that aggregates the results of each device instance that runs on a SAMI card 
by adding the subscriber count of all devices with the same serial number. Using the times given in the 
above example, if you view the GGSN subscriber report for the last 6 hours at 12:10 p.m., you see the 
results from GGSN A only, and only GGSN A contributes to those results. If you view the same report at 
12:15 p.m., you will see the sum of GGSN A and GGSN B subscriber counts, and both devices contribute 
to the results.

BWG Subscriber Count Reports

You can view any of the following BWG Subscriber Count Reports

• BWG Subscriber Count Hourly, page 13-56

• BWG Subscriber Count Daily, page 13-56

• BWG Subscriber Count Monthly, page 13-57

Related Topic

• Node Instance Counts in BWG and GGSN Subscriber Reports, page 13-55

BWG Subscriber Count Hourly

The BWG Subscriber Count Hourly Report table is sorted based on the information in the Subscriber 
Count column. However, you can sort the table based on the information in one of the other columns 
(see Navigating Table Columns, page 5-22).

BWG Subscriber Count Daily 

The BWG Subscriber Count Daily Report table is sorted based on the information in the Subscriber 
Count column. However, you can sort the table based on the information in one of the other columns 
(see Navigating Table Columns, page 5-22).

Field or Column Description

Timestamp (timezone) Timestamp of the report.

Serial Number Serial number of the chassis.

Subscriber Count Number of subscribers per node.

Node Instances Number of node instances per SAMI.

Field or Column Description

Timestamp (timezone) Timestamp of the report.

Serial Number Serial number of the chassis.

Subscriber Count Number of subscribers per node.

Node Instances Number of node instances per SAMI.
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BWG Subscriber Count Monthly

The BWG Subscriber Count Monthly Report table is sorted based on the information in the Subscriber 
Count column. However, you can sort the table based on the information in one of the other columns 
(see Navigating Table Columns, page 5-22).

CSG2 Subscriber Count Reports

You can view any of the following CSG2 Subscriber Count Reports

• CSG2 Subscriber Count Hourly, page 13-57

• CSG2 Subscriber Count Daily, page 13-57

• CSG2 Subscriber Count Monthly, page 13-58

CSG2 Subscriber Count Hourly

The CSG2 Subscriber Count Hourly Report table is sorted based on the information in the Subscriber 
Count column. However, you can sort the table based on the information in one of the other columns 
(see Navigating Table Columns, page 5-22).

CSG2 Subscriber Count Daily

The CSG2 Subscriber Count Daily Report table is sorted based on the information in the Subscriber 
Count column. However, you can sort the table based on the information in one of the other columns 
(see Navigating Table Columns, page 5-22).

Field or Column Description

Timestamp (timezone) Timestamp of the report.

Serial Number Serial number of the chassis.

Subscriber Count Number of subscribers per node.

Node Instances Number of node instances per SAMI.

Field or Column Description

Timestamp (timezone) Timestamp of the report.

Node Name of the node.

Serial Number Serial number of the chassis.

Subscriber Count Number of subscribers per node.

Field or Column Description

Timestamp (timezone) Timestamp of the report.

Node Name of the node.

Serial Number Serial number of the chassis.

Subscriber Count Number of subscribers per node.
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CSG2 Subscriber Count Monthly

The CSG2 Subscriber Count Monthly Report table is sorted based on the information in the Subscriber 
Count column. However, you can sort the table based on the information in one of the other columns 
(see Navigating Table Columns, page 5-22).

GGSN Subscriber Count Reports

You can view any of the following GGSN Subscriber Count Reports

• GGSN Subscriber Count Hourly, page 13-58

• GGSN Subscriber Count Daily, page 13-58

• GGSN Subscriber Count Monthly, page 13-59

Related Topic

• Node Instance Counts in BWG and GGSN Subscriber Reports, page 13-55

GGSN Subscriber Count Hourly

The GGSN Subscriber Count Hourly Report tables are sorted based on the information in the Subscriber 
Count column. However, you can sort each table based on the information in one of the other columns 
(see Navigating Table Columns, page 5-22).

GGSN Subscriber Count Daily 

The GGSN Subscriber Count Daily Report tables are sorted based on the information in the Subscriber 
Count column. However, you can sort the tables based on the information in one of the other columns 
(see Navigating Table Columns, page 5-22).

Field or Column Description

Timestamp (timezone) Timestamp of the report.

Node Name of the node.

Serial Number Serial number of the chassis.

Subscriber Count Number of subscribers per node.

Field or Column Description

Timestamp (timezone) Timestamp of the report.

Serial Number Serial number of the chassis.

Subscriber Count Number of subscribers.

Node Instances Number of node instances per SAMI.

Field or Column Description

Timestamp (timezone) Timestamp of the report.

Serial Number Serial number of the chassis.
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GGSN Subscriber Count Monthly 

The GGSN Subscriber Count Monthly Report table is sorted based on the information in the Subscriber 
Count column. However, you can sort the table based on the information in one of the other columns 
(see Navigating Table Columns, page 5-22).

HA Subscriber Count Reports

You can view any of the following HA Subscriber Count Reports

• HA Subscriber Count Hourly, page 13-59

• HA Subscriber Count Daily, page 13-59

• HA Subscriber Count Monthly, page 13-60

HA Subscriber Count Hourly

The HA Subscriber Count Hourly Report table is sorted based on the information in the Subscriber 
Count column. However, you can sort the table based on the information in one of the other columns 
(see Navigating Table Columns, page 5-22).

HA Subscriber Count Daily

The HA Subscriber Count Daily Report table is sorted based on the information in the Subscriber Count 
column. However, you can sort the table based on the information in one of the other columns (see 
Navigating Table Columns, page 5-22).

Subscriber Count Number of subscribers.

Node Instances Number of node instances per SAMI.

Field or Column Description

Field or Column Description

Timestamp (timezone) Timestamp of the report.

Serial Number Serial number of the chassis.

Subscriber Count Number of subscribers.

Node Instances Number of node instances per SAMI.

Field or Column Description

Timestamp (timezone) Timestamp of the report.

Node Name of the node.

Serial Number Serial number of the chassis.

Subscriber Count Number of subscribers.
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HA Subscriber Count Monthly 

The HA Subscriber Count Monthly Report table is sorted based on the information in the Subscriber 
Count column. However, you can sort the table based on the information in one of the other columns 
(see Navigating Table Columns, page 5-22).

Viewing File Archive Reports
Reports that have been archived are located within File Archive > Reports in the MWTM web interface. 
You can also find archived reports in the /opt/CSCOsgm/reports directory on the MWTM client. All 
archived reports are saved as export files in .csv format. 

You can view full descriptions of all fields in export file archive reports by clicking Administrative from 
the MWTM web interface, then clicking Export Reports README under System Information.

You can view any of the following archived reports:

• Custom ITP Archived Reports, page 13-61

• Daily Archived Reports, page 13-64

• Hourly Archived Reports, page 13-64

• 15 Minute Archived Reports, page 13-64

• Rolling ITP Archived Reports, page 13-64

• Access Point Name Archived Reports, page 13-65

• Application Server Archived Reports, page 13-66

• Application Server Process Archived Reports, page 13-67

• CPU Archived Reports, page 13-67

• CSG Archived Reports, page 13-68

• GTT Accounting Archived Reports, page 13-69

• GTT Rates Archived Reports, page 13-69

• GGSN Archived Reports, page 13-70

Field or Column Description

Timestamp (timezone) Timestamp of the report.

Node Name of the node.

Serial Number Serial number of the chassis.

Subscriber Count Number of subscribers.

Field or Column Description

Timestamp (timezone) Timestamp of the report.

Node Name of the node. 

Serial Number Serial number of the chassis.

Subscriber Count Number of subscribers.
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• HA Archived Reports, page 13-71

• Link Archived Reports, page 13-72

• Linkset Archived Reports, page 13-73

• Memory Archived Reports, page 13-74

• MLR Archived Reports, page 13-74

• MSU Archived Reports, page 13-75

• ActivationMTP3/AS Accounting Statistics Archived Reports, page 13-75

• Point Code Archived Reports, page 13-77

• Q752 Archived Reports, page 13-78

• RAN Archived Reports, page 13-78

• SCTP Archived Reports, page 13-79

Custom ITP Archived Reports

The Custom Archived Report pages show all archived MWTM custom network and accounting statistics 
reports for the server to which you connect. These reports can be viewed on the web, or downloaded as 
.zip files. These .zip files are also stored in the default directory (/opt/CSCOsgm by default) in the 
/reports/custom directory.

Note Custom archive reports are supported on ITP platforms only.

Note Custom reports are custom because you can specify that they run at custom time intervals. The content 
of custom reports is the same as regularly scheduled reports.

Custom archived reports are those that you enable by using these commands:

Note For detailed descriptions of these commands, see Appendix B, “Command Reference.”

Command Generates these custom statistics:

mwtm accstats MTP3/AS accounting

mwtm gttstats GTT

mwtm linkstats Link and linkset

mwtm mlrstats MLR

mwtm msustats MSU rates

mwtm mtpevents MTP3/AS events

mwtm q752stats Q.752

mwtm xuastats Application server and application server process
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Note Custom ITP reports can be run manually from the command line or setup to run at custom intervals by 
creating crontab entries. See Generating Custom ITP Statistics Reports Using the CLI, page 13-83 and 
Including or Excluding Specified Objects in ITP Reports, page 13-85 for more information.

The Custom Report tables are sorted based on the information in the Export File column. However, you 
can sort a table based on the information in one of the other columns (see Navigating Table Columns, 
page 5-22).

The Custom Report tables contain:

To show details in HTML for custom archived reports, click on a link in the View column of the Custom 
Archived Report page:

Column Description

Export File Name of the custom statistics export .zip file, archived by type, date, and hour; for example, the 
sgmLinksetStats.custom.20867.2009-06-24-16:15.csv.zip file contains the summary report of 
custom linkset statistics with the ID tag 20867 for the 15th minute of the 16th hour on June 24, 
2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a daily statistics 
report for that date. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can 
also import the file directly into Microsoft Excel.

Report Date (timezone) Date the custom report began.

Report Hour Time the custom report began.

Last Modified Date 
(timezone)

Date and time the custom report was last modified.

View Shows the detail report for the object. Not available for Q.752 reports.

Link Description

Aborts and Continues Daily MLR Aborts Reports, page 13-34

Daily MLR Continues Reports, page 13-35

Application Servers Hourly Application Server Reports, page 13-6

Application Server 
Processes

Hourly Application Server Process Reports, page 13-8

Events MTP3/AS Events Reports, page 13-76

GTT GTT Accounting Statistics Daily Summary Reports, page 13-53

Links Hourly Link Reports, page 13-23

Linksets Hourly Linkset Reports, page 13-29

Processed Daily MLR Processed Reports, page 13-36

ResultInvokes Daily MLR Result Invokes Reports, page 13-36

RuleMatches Daily MLR RuleMatches Reports, page 13-37
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All custom detail reports contain these headings and general menu options:

SubTriggers Daily MLR SubTriggers Reports, page 13-37

Triggers Daily MLR Triggers Reports, page 13-38

Link Description

Heading/ Menu Option Description

Date and Hour
(in heading)

Date and hour of the report.

Offset (in heading) Shows the number of rows in the table, prior to the first visible row; for example, if the first visible 
row is 501, the Offset is 500.

Number and Sort Order
(in heading)

Shows the number of records (rows) in the table, the column by which the table is sorted, and 
whether the sort is in ascending or descending order.

10/Page Shows 10 rows in the table.

20/Page Shows 20 rows in the table.

50/Page Shows 50 rows in the table.

100/Page Shows 100 rows in the table.

300/Page Shows 300 rows in the table.

500/Page Shows 500 rows in the table.

Max/Page Shows up to 15,000 rows in the table.

Note Depending on the number of rows, this could take up to 15 minutes.

DefPrefs Resets the /Page preferences for this web page to the default settings for the MWTM server.

First
(at bottom of table)

Shows the first page of entries for the table.

For example, if the table is sorted by Total Aborted in descending order, clicking this field shows 
the entries with the highest number of MSUs aborted by MLR.

You cannot click this field if the first page of entries is already visible.

Previous (Rows)
(at bottom of table)

Shows the previous page of entries for the table.

You cannot click this field if the first page of entries is already visible.

Next (Rows)
(at bottom of table)

Shows the next page of entries for the table.

You cannot click this field if the last page of entries is already visible.

Last
(at bottom of table)

Shows the last page of entries for the table.

For example, if the table is sorted by Total Aborted in descending order, clicking this field shows 
the entries with the lowest number of MSUs aborted by MLR.

You cannot click this field if the last page of entries is already visible.

Total
(at bottom of table)

Shows the total number of entries in the table.
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Daily Archived Reports

The Daily Archived Reports pages display summary reports for all report types that generate daily 
reports. You can also view a subset of daily file archive reports by selecting a report from the Type 
pulldown menu that appears at the top of the report list.

The .zip files are archived by type and date; for example, the 
sgmLinksetStats.DailySum.2009-06-22.csv.zip file contains the summary report of daily linkset statistics 
for the June 22, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
network statistics for all report types that generate daily reports. You can download the .zip files and 
extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Hourly Archived Reports

The Hourly Archived Reports pages show summary reports for all exported file archive reports that 
generate hourly reports. You can also view a subset of hourly file archive reports by selecting a report 
from the Type pulldown menu that appears at the top of the report list.

The summary reports of archived hourly network statistics are stored as downloadable .zip files. The .zip 
files are archived by type, date, and hour; for example, the sgmLinksetStats.2009-06-24-08.csv.zip file 
contains summary reports for the hourly linkset statistics for the eighth hour on June 24, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of 
hourly network statistics for all report types that generate daily reports. You can download the .zip files 
and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

15 Minute Archived Reports

The 15 Minute Archived Reports page shows summary reports for all archived MWTM 15-minute 
statistics for all report types that generate 15-minute reports. You can also view a subset of 15-minute 
file archive reports by selecting a report from the Type pulldown menu that appears at the top of the 
report list.

The summary reports of archived 15-minute statistics are stored as downloadable .zip files. The .zip files 
are archived by type and hour; for example, the sgmSCTPStats.2009-06-22-16-00.csv.zip contains the 
summary report of archived 15-minute statistics for June 22, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of 
15-minute statistics for all report types that generate 15-minute reports. You can download the .zip files 
and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Rolling ITP Archived Reports

The All Rolling Reports page shows summary reports of concatenated MWTM hourly and daily network 
statistics for all of the following objects detected by the MWTM for the server you are connected to:
13-64
User Guide for the Cisco Mobile Wireless Transport Manager 6.1.1

OL-13314-01



 

Chapter 13      Managing Reports
  Viewing Reports
• Application servers

• Application server processes

• Links 

• Linksets

These statistics are stored as downloadable .zip files. The .zip files are archived by type and number of 
days (7 or 30). For example:

• sgmLinkStats.RollingSevenDayAllHours.csv.zip

• sgmLinkStats.Rolling30DayAllDays.csv.zip 

• sgmASEStats.Rolling30DayAllDays.csv.zip

• sgmASEStats.RollingSevenDayAllHours.csv.zip

• sgmASPStats.Rolling30DayAllDays.csv.zip

• sgmASPStats.RollingSevenDayAllHours.csv.zip

• sgmLinkStats.Rolling30DayAllDays.csv.zip

• sgmLinkStats.RollingSevenDayAllHours.csv.zip

• sgmLinksetStats.Rolling30DayAllDays.csv.zip

• sgmLinksetStats.RollingSevenDayAllHours.csv.zip

Note To limit the maximum number of rows in export CSV files (for example, Excel can only handle 
65,535 rows.) See mwtm statreps, page B-75. 

Note Rolling Archived Reports are supported for ITP platforms only.

The MWTM creates a new set of files every hour.

You can download the .zip files and extract them. To download a .zip file, click a filename, then save the 
file to a location of your choice. You can also import the file directly into Microsoft Excel.

Access Point Name Archived Reports

You can access these reports:

• Daily Access Point Name Archived Reports, page 13-65

• Hourly Access Point Name Archived Reports, page 13-66

Daily Access Point Name Archived Reports

The Daily APN Archived Reports page shows summary reports for all archived MWTM daily network 
statistics for all access point names that the MWTM detects for the server to which you connect. MWTM 
creates the following APN Daily Archived reports every day:

• ApnStatsAggregatePdp.year-month-day.csv.zip

• ApnStatsAggregateThroughput.year-month-day.csv.zip 
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Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
network statistics for all application servers that the MWTM detects on that date and hour. You can 
download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Hourly Access Point Name Archived Reports

The Hourly APN Archived Reports page shows all summary reports for archived MWTM hourly 
network statistics for all access point names that the MWTM detects for the server to which you connect. 
MWTM creates the following APN Hourly Archived reports every hour:

• ApnStatsAggregateThroughput.year-month-day-hour.csv.zip 

• ApnStatsAggregatePdp.year-month-day-hour.csv.zip

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of 
hourly network statistics for all application servers that the MWTM detected on that date and hour. You 
can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Application Server Archived Reports

You can access the following Application Server Archived Reports. These reports are supported on ITP 
platforms only:

• Daily Application Server Archived Reports, page 13-66

• Hourly Application Server Archived Reports, page 13-66

• Custom ITP Archived Reports, page 13-61

Daily Application Server Archived Reports

The Daily AS Archived Reports page shows summary reports for all archived MWTM daily network 
statistics for all application servers that the MWTM detects for the server to which you connect. The 
information is stored as downloadable .zip files.

The .zip files are archived by type and date; for example, the sgmASEStats.DailySum.2009-06-22.csv.zip 
file contains the summary report for daily application server statistics for June 22, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
network statistics for all application servers that the MWTM detects on that date and hour. You can 
download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Related Topic

• Custom ITP Archived Reports, page 13-61

Hourly Application Server Archived Reports

The Hourly AS Archived Reports page shows all summary reports for archived MWTM hourly network 
statistics for all application servers that the MWTM detects for the server to which you connect. The 
information is stored as downloadable .zip files.
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The .zip files are archived by type, date, and hour; for example, the sgmASEStats.2009-06-22-08.csv.zip 
file contains the summary report for hourly application server statistics for the 8th hour on June 22, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of 
hourly network statistics for all application servers that the MWTM detected on that date and hour. You 
can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Application Server Process Archived Reports

You can access the following Application Server Process Archived Reports. These reports are supported 
on ITP platforms only:

• Daily Application Server Process Archived Reports, page 13-67

• Hourly Application Server Process Archived Reports, page 13-67

Daily Application Server Process Archived Reports

The Daily ASP Archived Reports page shows summary reports of all archived MWTM daily network 
statistics for all application server processes that the MWTM detects for the server to which connect, 
stored as downloadable .zip files.

The .zip files are archived by type and date; for example, the sgmASPStats.DailySum.2009-06-22.csv.zip 
file contains the summary report of daily application server process statistics for June 22, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
network statistics for all application server processes that the MWTM detected on that date and hour. 
You can download the .zip files and extract them.

To download a .zip file, right-click a filename, then save the file to a location of your choice. You can 
also import the file into Microsoft Excel.

Hourly Application Server Process Archived Reports

The Hourly ASP Archived Reports page shows the summary reports of all archived MWTM hourly 
network statistics for all application server processes that the MWTM detects for the server to which you 
connect, stored as downloadable .zip files.

The .zip files are archived by type, date, and hour; for example, the sgmASPStats.2009-06-22-11.csv.zip 
file contains the summary report of hourly application server process statistics for the 11th hour on June 
22, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with the summary report for 
hourly network statistics for all application server processes that the MWTM detected on that date and 
hour. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

CPU Archived Reports

You can access these following CPU Archived Reports:

• Daily CPU Archived Reports, page 13-68

• Hourly CPU Archived Reports, page 13-68
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Daily CPU Archived Reports

The Daily CPU Archived Reports page shows summary reports for all archived MWTM daily CPU 
statistics reports for the server to which you connect, stored as downloadable .zip files.

The .zip files are archived by type and date; for example, the CPUStats.2009-06-22.csv.zip file contains 
the summary report for daily CPU statistics for June 22, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
CPU statistics on that date and hour. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Hourly CPU Archived Reports

The Hourly CPU Archived Reports page shows all summary reports for archived MWTM hourly CPU 
statistics for the server to which you connect, stored as downloadable .zip files.

The .zip files are archived by type, date, and hour; for example, the CPUStats.2009-06-22-11.csv.zip file 
contains the summary report for hourly application server statistics for the 11th hour on June 22, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of 
hourly CPU statistics on that date and hour. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

CSG Archived Reports

You can access the following CSG Archived Reports:

• Daily CSG Archived Reports, page 13-68

• Hourly CSG Archived Reports, page 13-69

Daily CSG Archived Reports

The Daily CSG Archived Reports page shows summary reports of all archived MWTM daily CSG 
statistics. MWTM creates the following CSG daily archived report files each day:

• CsgStatsQuotaMgr.year-month-day.csv.zip

• CsgStatsLoadUserDb.year-month-day.csv.zip

• CsgStatsLoadSession.year-month-day.csv.zip

• CsgStatsLoadRadius.year-month-day.csv.zip

• CsgStatsLoadQuotaMgr.year-month-day.csv.zip

• CsgStatsLoadBma.year-month-day.csv.zip

• CsgStatsGlobal.year-month-day.csv.zip

• CsgStatsBma.year-month-day.csv.zip

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
CSG statistics on that date and hour. You can download the .zip files and extract them.

To download a .zip file, right-click a filename, then save the file to a location of your choice. You can 
also import the file into Microsoft Excel.
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Hourly CSG Archived Reports

The Hourly CSG Archived Reports page shows the summary reports of all archived MWTM hourly CSG 
statistics. MWTM creates the following CSG hourly archived report files for each hour:

• CsgStatsQuotaMgr.year-month-day-hour.csv.zip

• CsgStatsLoadUserDb.year-month-day-hour.csv.zip

• CsgStatsLoadSession.year-month-day-hour.csv.zip

• CsgStatsLoadRadius.year-month-day-hour.csv.zip

• CsgStatsLoadQuotaMgr.year-month-day-hour.csv.zip

• CsgStatsLoadBma.year-month-day-hour.csv.zip

• CsgStatsGlobal.year-month-day-hour.csv.zip

• CsgStatsBma.year-month-day-hour.csv.zip

To download a .zip file, right-click a filename, then save the file to a location of your choice. You can 
also import the file into Microsoft Excel.

GTT Accounting Archived Reports

You can access the following GTT Accounting Archived Reports. These reports are supported on ITP 
platforms only:

• Daily GTT Accounting Archived Reports, page 13-69

• Custom ITP Archived Reports, page 13-61

Daily GTT Accounting Archived Reports

The Daily GTT Accounting Archived Reports page shows all archived MWTM daily GTT accounting 
statistics reports for the server to which you connect, stored as downloadable .zip files.

The .zip files are archived by type and date; for example, the 
sgmGTTStats.DailyDetail.2009-06-24.csv.zip file contains the daily GTT accounting statistics report for 
June 24, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a daily GTT accounting 
statistics report for that date. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

GTT Rates Archived Reports

You can access the following GTT Rates Archived Report. This report is supported on ITP platforms 
only:

• Hourly GTT Rates Archived Reports, page 13-69.

Hourly GTT Rates Archived Reports

The Hourly GTT Rates Archived Reports page shows all archived MWTM hourly GTT rates statistics 
reports for the server to which you connect, stored as downloadable .zip files.
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The .zip files are archived by type, date, and hour; for example, the sgmGTTRates.2009-06-22-11.csv.zip 
file contains the hourly GTT rates statistics report for the 11th hour on June 22, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with an hourly GTT rates 
statistics report for that date. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

GGSN Archived Reports

You can access these reports:

• Daily GGSN Archived Reports, page 13-70

• Hourly GGSN Archived Reports, page 13-70

Daily GGSN Archived Reports

The Daily GGSN Archived Reports page shows summary reports of all archived MWTM daily GGSN 
statistics. MWTM creates the following GGSN subscriber daily archived report files each day:

• GgsnStatsAaaAccounting.year-month-day.csv.zip 

• GgsnStatsGlobalPdp.year-month-day.csv.zip 

• GgsnStatsGlobalPdpError.year-month-day.csv.zip

• GgsnStatsGlobalGtp.year-month-day.csv.zip 

• GgsnStatsApnInstancePdp.year-month-day.csv.zip 

• GgsnStatsApnInstanceThroughput.year-month-day.csv.zip

• GgsnStatsAaaAuthentication.year-month-day.csv.zip 

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
GGSN statistics on that date and hour. You can download the .zip files and extract them.

To download a .zip file, right-click a filename, then save the file to a location of your choice. You can 
also import the file into Microsoft Excel.

Hourly GGSN Archived Reports

The Hourly GGSN Archived Reports page shows the summary reports of all archived MWTM hourly 
GGSN statistic. MWTM creates the following GGSN hourly archived report files for each hour:

• GgsnStatsGlobalGtp.year-month-day-hour.csv.zip 

• GgsnStatsApnInstanceThroughput.year-month-day-hour.csv.zip 

• GgsnStatsApnInstancePdp.year-month-day-hour.csv.zip 

• GgsnStatsAaaAuthentication.year-month-day-hour.csv.zip

• GgsnStatsAaaAccounting.year-month-day-hour.csv.zip 

• GgsnStatsGlobalPdpError.year-month-day-hour.csv.zip 

• GgsnStatsGlobalPdp.year-month-day-hour.csv.zip 

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of 
hourly GGSN statistics on that date and hour. You can download the .zip files and extract them.
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To download a .zip file, right-click a filename, then save the file to a location of your choice. You can 
also import the file into Microsoft Excel.

HA Archived Reports

You can access these HA Archived Reports:

• 15 Minute HA IP Local Pool Statistics Archived Reports, page 13-71

• 15 Minute HA Registration Statistics Archived Reports, page 13-71

• Daily HA IP Local Pool Statistics Archived Reports, page 13-71

• Daily HA Registration Statistics Archived Reports, page 13-72

• Hourly HA IP Local Pool Statistics Archived Reports, page 13-72

• Hourly HA Registration Statistics Archived Reports, page 13-72

15 Minute HA IP Local Pool Statistics Archived Reports

The 15 Minute HA IP Local Pool Statistics Archived Reports page shows summary reports of 15-minute 
statistical details of the IP Local Pool. The 15 Minute HA IP Local Pool Statistics Archived Report has 
the file name IpLocalPoolStats.year.month-day-hour-minute.csv.zip. 

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of 
15-minute IP local pool statistics on that date, hour, and minute. You can download the .zip files and 
extract them.

To download a .zip file, right-click a filename, then save the file to a location of your choice. You can 
also import the file into Microsoft Excel.

15 Minute HA Registration Statistics Archived Reports

The 15 Minute HA Registration Statistics Archived Reports page shows summary reports of 15-minute 
statistical details on Home Agent registration and binding updates. The 15 Minute HA Registration 
Statistics Archived Report has the file name 
HomeAgentRegistrationStatsEntry.year.month-day-hour-minute.csv.zip.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of 
15-minute registration statistics on that date, hour, and minute. You can download the .zip files and 
extract them.

To download a .zip file, right-click a filename, then save the file to a location of your choice. You can 
also import the file into Microsoft Excel.

Daily HA IP Local Pool Statistics Archived Reports

The Daily HA IP Local Pool Statistics Archived Reports page shows summary reports of daily statistical 
details of the IP Local Pool. The Daily HA IP Local Pool Statistics Archived Report has the file name 
IpLocalPoolStats.year-month-day.csv.zip.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
IP local pool statistics on that date and hour. You can download the .zip files and extract them.

To download a .zip file, right-click a filename, then save the file to a location of your choice. You can 
also import the file into Microsoft Excel.
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Daily HA Registration Statistics Archived Reports

The Daily HA Registration Statistics Archived Reports page shows summary reports of daily statistical 
details on Home Agent registration and binding updates. The Daily HA Registration Statistics Archived 
Report has the file name HomeAgentRegistrationStatsEntry.year-month-day.csv.zip.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
registration statistics on that date and hour. You can download the .zip files and extract them.

To download a .zip file, right-click a filename, then save the file to a location of your choice. You can 
also import the file into Microsoft Excel.

Hourly HA IP Local Pool Statistics Archived Reports

The Hourly HA IP Local Pool Statistics Archived Reports page shows summary reports of hourly 
statistical details of the IP Local Pool. The Hourly HA IP Local Pool Statistics Archived Report has the 
file name IpLocalPoolStats.year-month-day-hour.csv.zip.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of 
hourly IP local pool statistics on that date and hour. You can download the .zip files and extract them.

To download a .zip file, right-click a filename, then save the file to a location of your choice. You can 
also import the file into Microsoft Excel.

Hourly HA Registration Statistics Archived Reports

The Hourly HA Registration Statistics Archived Reports page shows summary reports of hourly 
statistical details on Home Agent registration and binding updates. The Hourly HA Registration 
Statistics Archived Report has the file name 
HomeAgentRegistrationStatsEntry.year-month-day-hour.csv.zip

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of 
hourly registration statistics on that date and hour. You can download the .zip files and extract them.

To download a .zip file, right-click a filename, then save the file to a location of your choice. You can 
also import the file into Microsoft Excel.

Link Archived Reports

You can access the following Link Archived Reports. These reports are supported on ITP platforms only:

• Hourly Link Statistics Archived Reports, page 13-72

• Daily Link Statistics Archived Reports, page 13-73

• Custom ITP Archived Reports, page 13-61

Hourly Link Statistics Archived Reports

The Hourly Link Archived Reports page shows summary reports for all archived MWTM hourly network 
statistics for all links that the MWTM detected for the server to which you connect, stored as 
downloadable .zip files.

The .zip files are archived by type, date, and hour; for example, the sgmLinkStats.2009-06-24-09.csv.zip 
file contains the summary reports for hourly link statistics for June 24, 2009 at 9:00 a.m.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of an 
hourly network statistics for all links that the MWTM detected on that date and hour. You can download 
the .zip files and extract them.
13-72
User Guide for the Cisco Mobile Wireless Transport Manager 6.1.1

OL-13314-01



 

Chapter 13      Managing Reports
  Viewing Reports
To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Daily Link Statistics Archived Reports

The Daily Link Archived Reports page shows summary reports for all archived MWTM daily network 
statistics for all links that the MWTM detected for the server to which you connect, stored as 
downloadable .zip files.

The .zip files are archived by type and date; for example, the sgmLinkStats.DailySum.2009-06-24.csv.zip 
file contains the summary report of daily link statistics for June 24, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
network statistics for all links that the MWTM detected on that date and hour. You can download the .zip 
files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Linkset Archived Reports

You can access the following Linkset Archived Reports. These reports are supported on ITP platforms 
only:

• Hourly Linkset Statistics Archived Reports, page 13-73

• Daily Linkset Statistics Archived Reports, page 13-73

• Custom ITP Archived Reports, page 13-61 

Hourly Linkset Statistics Archived Reports

The Hourly Linkset Statistics Archived Reports page shows summary reports of all archived MWTM 
hourly network statistics for all linksets that the MWTM detects for the server to which you connect, 
stored as downloadable .zip files.

The .zip files are archived by type, date, and hour; for example, the sgmLinksetStats.2009-06-24.csv.zip 
file contains the summary report for the hourly linkset statistics for June 24, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of 
hourly network statistics for all linksets that the MWTM detected on that date and hour. You can 
download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Daily Linkset Statistics Archived Reports

The Daily Linkset Statistics Archived Reports page shows the summary report of all archived MWTM 
daily network statistics for all linksets that the MWTM detected for the server to which you connect, 
stored as downloadable .zip files.

The .zip files are archived by type and date; for example, the 
sgmLinksetStats.DailySum.2009-06-24.csv.zip file contains the summary reports of daily linkset 
statistics for June 24, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
network statistics for all linksets that the MWTM detected on that date and hour. You can download the 
.zip files and extract them.
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To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Memory Archived Reports

You can access the following Memory Archived reports:

• Daily Memory Archived Reports, page 13-74

• Hourly Memory Archived Reports, page 13-74

Daily Memory Archived Reports

The Daily Memory Archived Reports page shows summary reports for all archived MWTM daily 
memory statistics for the server to which you connect, stored as downloadable .zip files.

The .zip files are archived by type and date; for example, the MemStats.2009-06-22.csv.zip file contains 
the summary report for memory statistics for June 22, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
memory statistics on that date and hour. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Hourly Memory Archived Reports

The Hourly Memory Archived Reports page shows all summary reports for archived MWTM hourly 
memory statistics for the server to which you connect, stored as downloadable .zip files.

The .zip files are archived by type, date, and hour; for example, the MemStats.2009-06-22-08.csv.zip file 
contains the summary report for hourly memory statistics for the 8th hour on June 22, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of 
hourly memory statistics on that date and hour. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

MLR Archived Reports

You can access the following MLR Archived Reports. These reports are supported on ITP platforms 
only:

• Daily MLR Archived Reports, page 13-74

• Custom ITP Archived Reports, page 13-61

Daily MLR Archived Reports

The MLR Daily Archived Reports pages show all archived MWTM daily MLR processed, aborts, 
continues, result invokes, rule matches, subtriggers, and triggers statistics reports for the server to which 
you connect, stored as downloadable .zip files. MWTM creates the following MLR archived report files:

• sgmMLRStats.DailyAbortCons.year-month-day.csv.zip—Daily MLR aborts and report.

• sgmMLRStats.DailyProcessed.year-month-day.csv.zip—Daily MLR processed report.

• sgmMLRStats.DailyResultInvokes.year-month-day.csv.zip—Daily MLR result invokes report.
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• sgmMLRStats.DailyRuleMatches.year-month-day.csv.zip—Daily MLR rule matches report.

• sgmMLRStats.DailySubTriggers.year-month-day.csv.zip—Daily MLR subtriggers report.

• sgmMLRStats.DailyTriggers.year-month-day.csv.zip—Daily MLR triggers report.

Each archived .zip file contains a comma-separated value (CSV) text file with a daily MLR statistics 
report for that date. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

MSU Archived Reports

You can access the following MSU Archived Reports. These reports are supported on ITP platforms 
only:

• Hourly MSU Archived Reports, page 13-75

• Daily MSU Archived Reports, page 13-75

• Custom ITP Archived Reports, page 13-61 

Hourly MSU Archived Reports

The Hourly MSU Archived Reports page shows summary reports of all archived MWTM hourly MSU 
rates that the MWTM detects for the server to which you connect, stored as downloadable .zip files.

The .zip files are archived by type, date, and hour; for example, the 
itpHourlyMsuLoad.2009-06-24.csv.zip file contains the summary report for the hourly MSU rates for 
June 24, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of 
hourly MSU rates that the MWTM detected on that date and hour. You can download the .zip files and 
extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Daily MSU Archived Reports

The Daily MSU Archived Reports page shows the summary report of all archived MWTM daily MSU 
rates that the MWTM detected for the server to which you connect, stored as downloadable .zip files.

The .zip files are archived by type and date; for example, the itpDailyMsuLoad.2009-06-24.csv.zip file 
contains the summary reports of daily MSU rates for June 24, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
MSU rates that the MWTM detected on that date and hour. You can download the .zip files and extract 
them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Activation MTP3/AS Accounting Statistics Archived Reports

You can access the following MTP3/AS Accounting Statistics Reports. These reports are supported on 
ITP platforms only:

• Daily MTP3/AS Accounting Statistics Archived Reports, page 13-76
13-75
User Guide for the Cisco Mobile Wireless Transport Manager 6.1.1

OL-13314-01



 

Chapter 13      Managing Reports
  Viewing Reports
• Custom ITP Archived Reports, page 13-61

Daily MTP3/AS Accounting Statistics Archived Reports

The Daily MTP3/AS Accounting Statistics Archived Report page shows all archived MWTM daily 
MTP3/AS accounting statistics reports for the server to which you connect, stored as downloadable .zip 
files.

The .zip files are archived by date; for example, the sgmAccStats.DailyDetail.2009-06-24.csv.zip file 
contains the daily MTP3 accounting statistics report for June 24, 2009.

Note To limit the maximum number of rows in export CSV files (for example, Excel can only handle about 
65535 rows.) See mwtm statreps, page B-75. 

Each archived .zip file contains a comma-separated value (CSV) text file with a daily MTP3 accounting 
statistics report for that date. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

MTP3/AS Events Reports

You can access the following MTP3/AS Events Reports. These reports are supported on ITP platforms 
only:

• Hourly MTP3/AS Events Reports, page 13-76

• MTP3/AS Events Detail Reports, page 13-77

• Custom ITP Archived Reports, page 13-61

Hourly MTP3/AS Events Reports

To create hourly MTP3/AS event reports for the MWTM:

Step 1 Log in as the root user, as described in Starting the MWTM Client, page 4-2, or as a superuser, as 
described in Specifying a Super User (Server Only), page 2-17.

Step 2 Enter these commands:

# cd /opt/CSCOsgm/bin
# ./mwtm evreps enable
# ./mwtm evreps mtp

For more details on the mwtm evreps commands, see Appendix B, “Command Reference.”
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MTP3/AS Events Detail Reports

The MTP3/AS Events Archived Reports page shows all hourly MWTM MTP3/AS event reports for the 
server to which you connect. 

The .zip files are archived by type, date, and hour; for example, the sgmMTP3Events.2009-06-24.csv.zip 
file contains a summary report of the hourly MTP3 event for the eighth hour on June 24, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of an 
hourly MTP3 event for all objects that the MWTM detected on that date and hour. You can download the 
.zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Point Code Archived Reports

You can access the following Point Code Archived Report. This report is supported on ITP platforms 
only:

• Daily Point Code Archived Reports, page 13-78

Field or Column Description

Export File Name of the network events export .zip file, archived by type, date, and hour; for example, the 
sgmMTP3Events.custom.20867.2009-06-24-16-15.csv.zip file contains the summary report of custom 
network events with ID tag 20867 for the 15th minute of the 16th hour on June 24, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a daily statistics report for 
that date. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also import 
the file directly into Microsoft Excel.

Report Start Date 
(EST)

Date and time the custom report began.

Report Finish 
Date (EST)

Date and time the custom report ended.

Last Modified 
Date (EST)

Date and time the custom report was last modified.

View Shows the custom detail report for the object.

Field or Column Description

ID Identifier for the custom report, specified when you entered the mwtm mtpevents command. If you did 
not specify an ID, this field shows the process ID of the command that enabled the report.

Node Name of the node.

Index Number in the list shown in the CLI. 

MTP3 Event Text MTP3 event message as seen on the CLI.
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Daily Point Code Archived Reports

The Daily Point Codes Archived Reports page shows all archived MWTM daily point code inventory 
reports for the server to which you connect, stored as downloadable .zip files.

On the Point Codes Daily Archived Reports page, the .zip files are archived by date; for example, the 
sgmPointCodes.DailyInv.2009-06-24.csv.zip file contains the daily point code inventory report for June 
24, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a list of all point codes 
that were being used by all nodes that the MWTM detected on that date. You can download the The .zip 
files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Q752 Archived Reports

You can access the followingQ752 Archived Reports:

• Hourly Q752 Archived Reports, page 13-78

• Custom ITP Archived Reports, page 13-61

Hourly Q752 Archived Reports

The Q752 Archived Reports page shows all archived MWTM hourly Q.752 reports for the server to 
which you connect, stored as downloadable .zip files.

On the Q752 Archived Reports page, the .zip files are archived by date; for example, the 
sgmQ752Stats.2009-06-24.csv.zip file contains the hourly Q.752 report for June 24, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of all 
Q.752 links that the MWTM detected on that date. You can download the The .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

RAN Archived Reports

The RAN archived reports shows all the archived MWTM reports for the server to which you connected. 
You can access these reports:

Note PWE3 reports are available for IPRAN platforms with PWE3 data tunnels configured only. All 
other RAN reports are available for RAN-O platforms only.

• 15 Minute GSM Errors Archive Reports

• Daily GSM Errors Archive Reports

• Hourly GSM Errors Archive Reports

• 15 Minute PWE3 Performance Archive Reports

• Daily PWE3 Performance Archive Reports

• Hourly PWE3 Performance Archive Reports

• 15 Minute RAN Backhaul Archive Reports
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• Daily RAN Backhaul Archive Reports

• Hourly RAN Backhaul Archive Reports

• 15 Minute RAN Congestion Archive Reports

• Daily RAN Congestion Archive Reports

• Hourly RAN Congestion Archive Reports

• 15 Minute RAN Shorthaul Archive Reports

• Daily RAN Shorthaul Archive Reports

• Hourly RAN Shorthaul Archive Reports

• 15 Minute UMTS Errors Archive Reports

• Daily UMTS Errors Archive Reports

• Hourly UMTS Errors Archive Reports

The RAN Archived Reports page shows all archived MWTM RAN reports for the server to which you 
connect, stored as downloadable .zip files.

The .zip files are archived by date; for example, the ranoBHStats2009-06-24.csv.zip file contains the 
daily RAN Backhaul report for June 24, 2009. 

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel. 

SCTP Archived Reports

You can access the following SCTP Archived Report:

• 15 Minute SCTP Archived Reports, page 13-79

15 Minute SCTP Archived Reports

The 15 Minute SCTP Archived Reports page shows all archived MWTM SCTP 15 minute reports for the 
server to which you connect, stored as downloadable .zip files.

On the SCTP 15 Minute Archived Reports page, the .zip files are archived by date; for example, the 
sgmSCTPStats.2009-06-22-11-30.csv.zip file contains the SCTP 15-minute report for the 11th hour, 30 
minutes on June 22, 2009.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of all 
SCTP links that the MWTM detected on that date. You can download the The .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Viewing the MWTM Statistics Reports Logs

You can view a log that contains all messages pertaining to MWTM reports, and a display of the current 
values of MWTM report parameters and timers.

This section contains this information:

• Viewing the MWTM Report Log, page 13-80

• Viewing the MWTM Report Parameters and Timers, page 13-80
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Viewing the MWTM Report Log

For details on viewing the MWTM report log, see Viewing the Report Log, page 12-14.

Viewing the MWTM Report Parameters and Timers

The Report Parameters and Timers page shows the current values of report parameters and timers for the 
server to which you connect, and which is currently running the MWTM server.

To access the Report Parameters and Timers page, you must run the mwtm statrep CLI command on 
the server.

Column Description

AcctReports Indicates whether the MWTM should generate MTP3 accounting statistics reports. For more 
information, see the description of the mwtm statreps [acct | noacct] command in mwtm status, 
page B-81.

CPUReports Indicates whether the MWTM should generate CPU statistics reports. For more information, see the 
description of the mwtm statreps [ggsn | noggsn] command in mwtm statreps, page B-75.

CSGReports Indicates whether the MWTM should generate CSG statistics reports. For more information, see the 
description of the mwtm statreps [ggsn | noggsn] command in mwtm statreps, page B-75.

Custom Age Indicates the maximum number of days the MWTM should archive custom network statistics reports. 
For more information, see the description of the mwtm statreps custage and mwtm repcustage 
commands in mwtm statreps, page B-75.

Daily Age Indicates the maximum number of days the MWTM should archive daily network statistics reports. For 
more information, see the description of the mwtm statreps dailyage and mwtm repdailyage 
commands in mwtm statreps, page B-75.

DiskCheck Indicates whether the MWTM should verify that a disk has at least 10 MB of space remaining before 
enabling network statistics reports. For more information, see the description of the mwtm statreps 
[diskcheck | nodiskcheck] command in mwtm statreps, page B-75.

ExportReports Indicates whether the MWTM should generate network statistics reports in export format. For more 
information, see the description of the mwtm statreps [export | noexport] command in mwtm statreps, 
page B-75.

GGSNReports Indicates whether the MWTM should generate GGSN statistics reports. For more information, see the 
description of the mwtm statreps [ggsn | noggsn] command in mwtm statreps, page B-75.

GTTRatesReports Indicates whether the MWTM should generate GTT Rates statistics reports. For more information, see 
the description of the mwtm statreps [gttrates | nogttrates] command in mwtm statreps, page B-75.

GTTReports Indicates whether the MWTM should generate GTT accounting statistics reports. For more information, 
see the description of the mwtm statreps [gtt | nogtt] command in mwtm statreps, page B-75.

HAReports Indicates whether the MWTM should generate HA statistics reports. For more information, see the 
description of the mwtm statreps [ha | noha] command in mwtm statreps, page B-75.

Hourly Age Indicates the maximum number of days the MWTM should archive hourly network statistics reports. For 
more information, see the description of the mwtm statreps hourlyage and mwtm rephourlyage 
commands in mwtm statreps, page B-75.

IPLinks For ITP link and linkset reports only. Indicates whether the MWTM should include links that use the 
Stream Control Transmission Protocol (SCTP) IP transport protocol in network statistics reports. For 
more information, see the description of the mwtm statreps [iplinks | noiplinks] command in mwtm 
statreps, page B-75.
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LinkReports Reports of ITP link and linkset statistics. 

Max CSV Rows Indicates the maximum number of rows the MWTM should include in export CSV files. For more 
information, see the description of the mwtm statreps maxcsvrows command in mwtm statreps, 
page B-75.

MEMReports Indicates whether the MWTM should generate Memory statistics reports. For more information, see the 
description of the mwtm statreps [csg | nocsg] command in mwtm statreps, page B-75.

MLRReports Indicates whether the MWTM should generate MLR statistics reports. For more information, see the 
description of the mwtm statreps [mlr | nomlr] command in mwtm statreps, page B-75.

MSUReports Indicates whether the MWTM should generate MSU rates reports. For more information, see the 
description of the mwtm statreps [msu | nomsu] command in mwtm statreps, page B-75.

NullCaps Indicates whether the MWTM should include SCTP links that do not have planned send and receive 
capacities in network statistics reports. For more information, see the description of the mwtm statreps 
[nullcaps | nonullcaps] command in mwtm statreps, page B-75.

PWE3Reports Indicates whether the MWTM should generate PWE3 statistics reports. For more information, see the 
description of the mwtm statreps [pwe3 | nopwe3] command in mwtm statreps, page B-75.

Q752Reports Indicates whether the MWTM should generate Q.752 reports. For more information, see the description 
of the mwtm statreps [q752 | noq752] command in mwtm statreps, page B-75.

RANOReports Indicates whether the MWTM should generate RANO statistics reports. For more information, see the 
description of the mwtm statreps [rano | norano] command in mwtm statreps, page B-75.

Report Dir Path and name of the directory in which the MWTM stores reports. The default reports directory is 
/opt/CSCOsgm/reports, but you can change the reports directory using the mwtm repdir command (see 
mwtm repdir, page B-54).

SCTPReports Indicates whether the MWTM should generate SCTP statistics reports. For more information, see the 
description of the mwtm statreps [sctp | nosctp] command in mwtm statreps, page B-75.

ServRatio For ITP link and linkset reports only. In-Service values that are outside a normal range are indicated with 
a red status ball icon in the In-Service cell. An In-Service value is outside the normal range if the 
following condition is met:

Current In-Service < factor * Long-Term In-Service

This inequality is used to recognize drops in the In-Service value. Assuming the default factor of 0.95, 
the Current In-Service value must be greater than or equal to 95% of the Long-Term In-Service value to 
be in the normal range.

For more information, see the description of the mwtm statreps servratio command in mwtm statreps, 
page B-75.

Status Indicates whether the MWTM should generate network statistics reports. For more information, see the 
description of the mwtm statreps [disable | enable] command in mwtm statreps, page B-75.

TimeMode Indicates the time mode for dates in network statistics reports. For more information, see the description 
of the mwtm statreps timemode [12 | 24] command in mwtm statreps, page B-75.

Timer files Indicates timer activities during the last report run by the MWTM. The timer file is useful for identifying 
how much time the MWTM spends gathering report data and generating reports.

Column Description
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Locating Stored Reports
The MWTM stores all reports in the report files directory on the /reports directory. If you installed the 
MWTM in:

• The default directory, /opt, then the default report files directory is /opt/CSCOsgm/reports.

• A different directory or used the mwtm repdir command to specify a new directory in which the 
MWTM should store report files, then the default report files directory resides in that directory.

Note For details on changing the default reports directory by using the mwtm repdir command, see Changing 
the MWTM Reports Directory, page 13-83.

The /reports directory contains these subdirectories:

UtilRatio For ITP link and linkset reports only. Values that are outside a normal range are indicated with a red 
status ball icon in the Send or Receive cell. A value is outside the normal range if the following condition 
is met:

Current  > factor * Long-Term 

This inequality is used to recognize increases in the value. Assuming the default factor of 1.5, the Current 
value must be less than or equal to 150% of the Long-Term value to be in the normal range.

The default value for factor is 1.5.

For more information, see the description of the mwtm statreps utilratio command in mwtm statreps, 
page B-75.

Web Names Indicates whether the MWTM should show real node names or display names in web pages. For more 
information, see the description of the mwtm webnames [display | real] command in the mwtm 
webnames, page B-92.

Web Util For ITP link and linkset reports only. Indicates whether the MWTM should display send and receive for 
linksets and links as percentages or in Erlangs (E), in web pages. For more information, see the 
description of the mwtm webutil [percent | erlangs] command in mwtm who, page B-93.

XUAReports Indicates whether the MWTM should generate accounting statistics reports for application servers and 
application server processes. For more information, see the description of the mwtm statreps 
[xua | noxua] command in mwtm statreps, page B-75.

Column Description

Subdirectory Description

/custom Contains all custom report files. These are the report files that you generate using these commands:
mwtm accstats, mwtm gttstats, mwtm linkstats, mwtm mlrstats, mwtm mtpevents, 
mwtm q752stats, and mwtm xuastats 

Note A unique ID tag, specified when you enter the command, identifies each file. If the user does not 
specify an ID tag, the MWTM uses the process ID of the command.

/etc Contains additional files that the MWTM reporting scripts and web pages use, including the 
nodes.include, linksets.include, nodes.exclude, linksets.exclude and filter.include files, if they exist.

/export15min Contains all 15 minute report files exported in csv.zip format.
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Changing the MWTM Reports Directory
On the server, you can change the directory in which the MWTM stores reports.

To change the MWTM report files directory, log in as the root user, as described in Starting the MWTM 
Client, page 4-2; or, as a superuser, as described in Specifying a Super User (Server Only), page 2-17, 
and enter:

# cd /opt/CSCOsgm/bin
# ./mwtm repdir directory

where directory is the new directory.

Note This command copies all files in the current directory to the new directory. If you log in as the superuser 
and you do not own the new directory, you might not be able to copy the files. In that case, you must 
specify a directory that you own or log in as the root user.

Customizing ITP Reports
The following sections include information about generating and modifying ITP reports:

• Generating Custom ITP Statistics Reports Using the CLI, page 13-83

• Including or Excluding Specified Objects in ITP Reports, page 13-85

Generating Custom ITP Statistics Reports Using the CLI
In the MWTM, you can use custom ITP CLI commands to create summary reports of custom ITP 
statistics and open them as an export file. To create a custom report:

Step 1 Log in as the root user, as described in Starting the MWTM Client, page 4-2, or as a superuser, as 
described in Specifying a Super User (Server Only), page 2-17.

Step 2 Enter:

# cd /opt/CSCOsgm/bin

/exportdaily Contains all daily report files exported in csv.zip format.

/exporthourly Contains all hourly report files exported in csv.zip format.

/exportrolling Contains all rolling report files for these statistics: 

• Application server

• Application server process

• Link

• Linkset

Files are edited and formatted for export and stored as .zip files in CSV format. The MWTM rebuilds the 
files in this subdirectory every hour.

Subdirectory Description
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Step 3 Based on the type of custom report you want to generate, enter one of these commands to enable the 
report:

Note For complete information about these commands, see Appendix B, “Command Reference.”

For example, if you entered the command:

# ./mwtm accstats mwtm-2600a.cisco.com test1

where test1 is name tag added to the file name to make it easier to find the report.

The MWTM generates these reports:

mwtmAccStats.custom.test1.2004-02-13:15.csv.zip
mwtmAccStats.custom.test1.2004-02-13:15.csv.zip

To generate a report for all nodes, do not specify a node name as shown in the following example:

# ./mwtm accstats 

Step 4 (Optional) To include or exclude specific nodes, signaling points or linksets in the report, see NoteThe 
MWTM processes the include files first, then the exclude files., page 13-86.

Step 5 (First-time users only) If this is your first time using the mwtm accstats, mwtm gttstats, 
mwtm mlrstats, mwtm mtpevents, mwtm q752stats, or mwtm xuastats command to generate a 
custom ITP report, you must enter the command one more time. The:

• First entry gets the first set of raw data.

• Second entry begins calculating useful accounting statistics and, if the data being collected appears 
valid, begins generating the report.

or

If this is your first time using the mwtm linkstats command to generate a custom ITP report, you must 
enter the command two more times. The:

• First entry gets the first set of raw data.

• Second entry begins calculating useful link and linkset statistics.

• Third entry continues to calculate statistics, calculates long-term averages, and, if the data being 
collected appears to be valid, begins generating the report.

Thereafter, you need only enter these commands once to generate the ITP custom report.

Table 13-1 Custom Report Commands

Custom Report Command

Application server and application server 
processes custom statistics

mwtm xuastats

GTT accounting statistics mwtm gttstats

Link and linkset summary mwtm linkstats

MLR statistics mwtm mlrstats

MTP3 accounting statistics mwtm accstats 

MTP3 event summary mwtm mtpevents 

Q.752 statistics mwtm q752stats 
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Step 6 (Optional) You can automate custom ITP report generation using crontab. For example, to run custom 
MTP3 accounting statistics every 30 minutes, enter:

00, 30 * * * *  /opt/CSCOsgm/bin/mwtm accstats quiet

or, to run custom link statistics every 15 minutes, enter:

00,15,30,45 * * * *  /opt/CSCOsgm/bin/mwtm linkstats quiet

Step 7 You can view custom ITP reports on the MWTM Web interface under File Archive > Reports > 
Custom. Click on the respective link in the View column to see the data in HTML, or click on a .zip file 
to see the data in .csv format.

Note You can only view Q.752 reports in .csv format.

The MWTM also stores custom reports in the /custom directory (for details, see Locating Stored Reports, 
page 13-82.)

Including or Excluding Specified Objects in ITP Reports
You can include or exclude specific nodes, signaling points, or linksets in ITP reports by creating 
user-defined files. The nodes, signaling points, and/or linksets that you specify in these files will be 
included or excluded from enabled MWTM statistics reports and in custom reports enabled with the 
default keyword (or no node-list keyword at all), which include:

Command Filename1

mwtm linkstats nodes.include.linkstats or nodes.include

nodes.exclude.linkstats or nodes.exclude

linksets.include.linkstats or linkstats.include

linksets.exclude.linkstats or linkstats.exclude

mwtm q752stats nodes.include.q752stats or nodes.include

nodes.exclude.q752stats or nodes.exclude

linksets.include.q752stats or linkstats.include

linksets.exclude.q752stats or linkstats.exclude

mwtm accstats nodes.include.accstats or nodes.include

nodes.exclude.accstats or nodes.exclude

linksets.include.accstats or linkstats.include

linksets.exclude.accstats or linkstats.exclude

filter.include.accstats or filter.include2
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Note The MWTM processes the include files first, then the exclude files.

When creating user-defined files, remember that if you installed the MWTM in:

• The default directory, /opt, then the user-defined file resides in /opt/CSCOsgm/reports/
etc/<user-defined file>.

A different directory, or if you moved the report files directory using the mwtm repdir command, 
then the /reports/etc/<user-defined file> resides in that directory.

• Wildcard matching is not supported.

• If a node, signaling point, or linkset appears in both the include file and the exclude file, it is 
excluded. That is, excluding an object overrides including the same object.

• If you specify a special include file on the mwtm accstats, mwtm gttstats, mwtm linkstats, 
mwtm mlrstats, mwtm mtpevents, mwtm q752stats, or mwtm xuastats command, the MWTM 
ignores the include or exclude file. 

When creating a nodes.include or nodes.exclude file:

Each line in the file must contain a single node name, or node name and signaling point name, 
separated by a colon (:) that matches exactly the real, fully qualified name of the node; for example:

mwtm-75-59a.cisco.com
mwtm-26-51a.cisco.com

To include a specific signaling point, specify the node name and signaling point:

mwtm-75-59a.cisco.com;net0
mwtm-26-51a.cisco.com;net0

When creating a linksets.include or linksets.exclude file:

Each line in the file must contain a single linkset name that matches exactly the real, fully qualified 
linkset name of the linkset, including the node name and signaling point name; for example:

mwtm gttstats nodes.include.gttstats or nodes.include

nodes.exclude.gttstats or nodes.exclude

linksets.include.gttstats or linkstats.include

linksets.exclude.gttstats or linkstats.exclude

filter.include.gttstats or filter.include3

mwtm mtpevents nodes.include.mtpevents or nodes.include

nodes.exclude.mtpevents or nodes.exclude

mwtm mlrstats nodes.include.mlrstats or nodes.include

nodes.exclude.mlrstats or nodes.exclude

mwtm xuastats nodes.include.xuastats or nodes.include

nodes.exclude.xuastats or nodes.exclude

1. Files on the command line override system files. For example, nodes.include.accstats 
overrides nodes.include.

2. Format is opc:dpc (originating point code and destination point code).

3. Format is gta:sel (global title address and selector).

Command Filename1
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mwtm-75-59a.cisco.com;net0:linkset2
mwtm-26-51a.cisco.com;net0:linkset1

When creating a filter.include file: 

Each line in the file must contain a single originating point code and destination point code (for 
accounting statistics) that matches the current point code format; or a single phone number and 
selector name (for GTT statistics); for example:

1.2.3:5.6.7
8882214040:Selector_1
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